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Editor’s letter
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Three of my top  
picks this month…EDITOR’S CHOICE

Claire Howlett, Editor
claire@imaginefx.com 

Inspiration and hard work! It’s 
really as simple as that when it 
comes to making the most of 
your art. We can definitely  
give you plenty of the first –
hopefully enough so that the 
hours and hours you put into 
your art doesn’t really feel like 
work at all! 

It certainly never seems like hard work on 
ImagineFX – not when you get the likes of Magic: 
The Gathering’s art supremo Cynthia Shepherd 
revealing the thought process of the new card pack 
(page 28), or getting into the mind of legend Allen 
Williams (page 36) – an artist whose work I’ve 
enjoyed exploring through his great posts on 
Facebook. They’re like delightfully disturbing treats 
nestling within an otherwise selfie-plastered wall. 
Allen has a knack for giving his fans just enough art 
and info on social media to make us want to know 
more about his projects. Over in the news feature 
(page 24), we discuss the different approaches that 
artists can take to social media, with a bunch of 
brilliant artists with a range of views on the subject.

And did I mention the amazing cover? Erik Jones 
has provided an eye-exploding surreal colour piece 
that’s explored and explained on page 62. Enjoy!

Sketchbook double-whammy! 
Tobias Kwan and Daria Theodora’s pencil art is a perfect 
fit for this issue’s surreal theme, wouldn’t you say?

Multi-purpose creative hub
I loved nosing around Jake Parker’s studio. Such an 
inspiring space – and there’s room for meditation, too!

Free  
software!
Find out how you  

can get ArtRage Lite 

(worth $30) for FREE!  

Turn the page for  

more details…

mail@imaginefx.com

@imaginefx

facebook.com/imaginefx

@imaginefxmagazine

imaginefx.creativebloq.com

Welcome to…
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Being inspired by a surreal art master
I was more than happy to take up Rafael Sarmento’s 
offer of painting an homage to the work of Beksinski.

48 54
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Get your 
FREE GIFT 

today!

Free software! 
Get ArtRage Lite worth 
$30 when you subscribe!

Brilliant value 
Subscribe to save money 
off the cover price.

Exclusive covers 
Subscribers receive issues 
with text-free covers.

No-hassle delivery 
ImagineFX gets sent direct 
to your door or device.

Subscribe to

Take out a new subscription to our print or print and digital 

editions, and you’ll receive a FREE COPY of ArtRage Lite! 

Subscribe and save!
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Workshops 
62 Learn to paint a surreal portrait 
Erik Jones shows how he brings abstract 
shapes into his stunning character art.

68 Revisit Beksinski’s  
surreal world
Rafael Sarmento salutes one of the 20th 
century’s most inspiring surreal artists.

74 Paint a corpse that’s  
full of life and colour
Discover how Peter Polach elevates the 
mood of a traditionally grim topic.

78 Core Skills: Photoshop
Mark White uses Layer Styles to improve 
his art, and places them effectively.

82 Effective costume designs
Paul Gerrard treads the fine line between 
concept art and workable costume designs.

Traditional Artist
98 Traditional art FXPosé
We showcase the best art created using 
traditional methods, sent in by you! 

102 Workshop: The importance  
of storytelling
Iris Compiet reveals how she sketches  
and paints a fantasy character, and tells 
their story in a single image.
 
108 Workshop: Use texture in a 
ghostly scene
AM Sartor takes an indirect approach to 
her art, as she depicts a mythical figure.

114 First Impressions:  
Jim Pavelec
Inspiration lay within a medieval grimoire!

48 68
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108102

82

Create better fantasy costumes

Homage to Beksinski

Craft a surreal portrait piece

Use textureStorytelling advice

´

´Sketchbook: Tobias Kwan



GET YOUR 
RESOURCES

 

1Go to the website
Type this into your browser’s 

address bar (not the search bar):  

https://ifxm.ag/surreal161portraits

2Find the files you want
Search through the list of 

resources to download.

3Download what you need…
…or alternatively watch the 

videos on our YouTube page.

Getting hold of this issue’s videos and custom 
brushes is quick and easy. Just visit our dedicated 
web page at https://ifxm.ag/surreal161portraits of video tutorials from pro artists  to watch and  learn from!

OVER  5 HOURS 

COVER WORKSHOP

Learn how to create a surreal portrait
You won’t have missed Erik Jones’ stunning cover art – in his video he reveals how he works both 
traditionally and digitally to produce such captivating portraits. Read his workshop on page 62.

Resources

8 June 2018



Future PLC Quay House,  
The Ambury, Bath BA1 1UA

Use texture in a ghostly scene 
See how AM Sartor adds visual interest in her 
video. There’s more over on page 108.

Paint a lively, colourful corpse
Watch Peter Polach use colour to great effect, 
then turn to page 74 for more ghoulish fun.

Lesson 01: Ursus Warbear
Check out a clip from Weta artist Dongjun 
Lu’s training video. We review it on page 93.

Revisit Beksinski’s surreal world
Watch Rafael Sarmento’s workshop video as he channels his admiration and enthusiasm for 
the late Polish painter, then turn to page 68 to learn more about his approach.
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Neeraj Menon

A fan of comics and animation from childhood, Neeraj 

felt it only natural to pursue a career in the visual arts. 

He now works as a comic colourist and concept artist.

LOCATION: India  MEDIA: Photoshop, ZBrush, KeyShot, Marvelous Designer   

WEB: www.artstation.com/neerajmenon

10 June 2018

THE PLACE TO SHARE YOUR DIGITAL ART
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June 2018

1
MAN OF TOMORROW

“Fan art depicting the Man of Steel after 

he’s outlived all of humanity. I keep a model 

skull handy, and I use a flashlight on it for a 

quick lighting reference.”

2
QHEL

“The flagbearer of Death, rising up from 

her murky realm. I approached this like a 

photoshoot with a live model, using 3D 

geometry pinned and lit to look ‘just right’ 

only from this angle.”

3
TSIII

“A punk cyborg in standby mode. 

Learning to work with Marvelous Designer 

was very liberating for me, because I no 

longer need to find clothing references that  

fit what’s in my head.”

11June 2018
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Edmund Chan
Edmund is a freelance concept artist from Malaysia. “I have great 

appreciation for natural environments and the culture that surrounds  

them,” he says. He also finds inspiration in films and video games.

LOCATION: Malaysia  MEDIA: Photoshop , Illustrator, SketchUp, ZBrush  WEB: www.artstation.com/popchan

12 June 2018 Want to submit your work? Visit http://ifxm.ag/getinifx
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1POLLUTED SLUMS

“I wanted to show that human beings are a 

greedy form of life. Even with a new Earth, 

pollution would not stop.”

2RED PLANET

“A stranded astronaut discovers signs of 

life similar to ours on a distant planet.”

3TRAVERSE

“I’m always fascinated by space travel and 

the idea that someday, humans will find 

something familiar but yet alien.”

4CANYON PARADISE

“This piece is heavily inspired by classic 

cowboy movies. It depicts a traveller who 

stumbles upon a lush environment. It could  

be a mirage.”

13June 2018Want to submit your work? Visit http://ifxm.ag/getinifx
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Want to submit your work? Visit http://ifxm.ag/getinifx

Alicia Lamburd
Aspiring concept artist Alicia taught herself digital painting using 

open source software such as Krita. “I always strive for a sense of 

scale in fantastical worlds filled with unknowns,” she says.

LOCATION: Australia MEDIA: Krita, Photoshop, Sculptris  WEB: www.artstation.com/alicialamburd

1THE HIDDEN RAVINE

“This was my first digital 

landscape I drew back in 2015. 

I gave the original version a 

quick repaint in mid-2017 to 

bring it up to date a little bit.”

2THE FORTRESS

“A quick piece to test new 

brushes and textures. I love the 

look of fortresses, especially 

those that sit in the kind of 

fantastical landscapes it  

would be impossible to 

construct such a thing in.”

14 June 2018
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Want to submit your work? Visit http://ifxm.ag/getinifx

Damian Edwardson

Damian studied illustration before teaching himself digital art. 

“The best advice I got was treat digital painting like you would a 

traditional medium. It changed my whole approach,” he says.

LOCATION: England  MEDIA: Photoshop, Procreate  WEB: www.damianedwardsonart.com

15June 2018

1BATMAN: MY LIFE IS 

STILL COMPLEX

“I’m intrigued by heroes 

and villains getting older 

and showing the signs of 

their past battles. For me 

Michael Keaton was, and 

still is, Batman. ”

2THE THIRD 

DOCTOR

“One of a series of pieces 

I’m doing on all the 

Doctors. Although Tom 

Baker was my Doctor, 

Jon Pertwee has a face 

that was designed to be 

painted. So I did.”

3DREDD:  

40 LONG YEARS

“I wanted to show the 

results of 40 years of 

patrolling the means 

streets of Mega City 

One. I love Dredd –  

2000 AD played a  

big part in my love of 

comics and art.”

1

2

3



Want to submit your work? Visit http://ifxm.ag/getinifx16 June 2018

1

3ASPIRATIONS

“I became obsessed with red-tailed 

monkeys after discovering them at San 

Diego Zoo, and was inspired to feature 

them in my art. This is my interpretation  

of a struggling artist.”

Erik Ly
Erik’s work is characterised by crisp line work, 

powerful colours and thought-provoking imagery.  

As well as digital art, he also creates art videos for fun.

LOCATION: US  MEDIA: Photoshop  WEB: www.instagram.com/eriklyart

1DROWNING

“The inspiration for this was my girlfriend’s 

horrible commute to her tough job every day. 

This piece was very refreshing for me as I 

don’t often use green colours in my artwork.”

2TO SERVE

“What can I say? I love samurai and 

skeletons. The original idea spawned from my 

back pain at the time and the back burster 

scene in the Alien Covenant trailer.”

3
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4ELEGY

“This started out as  

a material render test for 

myself, and developed into 

something very personal.  

I wanted to mix a very  

soft rendering style with  

my illustrative approach.”

17June 2018Want to submit your work? Visit http://ifxm.ag/getinifx
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1
IN-HABITATION  EPISODE 4

“Shipwrecks have played a role in 

representing untold stories and 

mystery. This image aims to pique 

the viewer’s curiosity as this form 

washes up on a future coastline.”

2
DUSK

“This image explores the purity 

of form and scale that’s present in 

design, but also the importance of 

our view and our visual connection 

to the environment.”

Nicholas Stathopoulos

Nicholas works across the architecture and entertainment 

industries. His art combines destructive and overscaled 

structures with rural landscapes to create a sense of strangeness.

LOCATION: Australia  MEDIA: Photoshop  WEB: www.nickstath.com

3
DOCK

“The dystopic nature of 

this art depicts the start of a 

colonisation process taking 

place on another world, 

without any sympathy for the  

natural environment.”

18 June 2018

1

2

3



Sandra Süsser

Sandra is an illustrator, game artist and concept artist. She’s 

studying communication design, but is also already working 

with clients on different game and film projects.

LOCATION: Germany  MEDIA: Photoshop, Illustrator  WEB: www.sandra-suesser.de

1CONSTRAINED

“Sometimes you feel as if 

you’re constrained by some 

invisible force, dragging you 

down. I have hope that I’ll 

eventually break free from the 

chains made by myself.”

19June 2018
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Eyal Navon

Eyal credits the online community with helping him develop as  

an illustrator. “At some point, my room became an oasis and I no  

longer felt alone as an artistic soul,” he says. 

LOCATION: Germany  MEDIA: Photoshop  WEB: eyaldraws.weebly.com

1BRING YOU THERE

“I love to bring stories 

into my pictures, and fill 

them with beautiful 

human emotions that  

I’ve experienced in my 

own life. Anyone should 

be able to understand or 

feel them.”

2YARA: NOT WITH ME

“Yara spearheads an 

anti-fascist movement in a 

post-apocalyptic age. 

Irrespective of her 

situation, she always has a 

good sense of humour. 

She’s a bit like Deadpool, 

but more peaceful.”

20 June 2018
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3
COWGIRL

“A wonderful young lady 

and her buddy. They wander 

among the red cliffs of Texas 

and embark on an adventure. 

Their goal? That’s this 

magnificent madam’s secret. 

The horse knows nothing 

about it.”

4
BORIA’S LAST MISSION

“A portrait of Boria 

before his final fight against 

the three-headed Hydra.  

I created this character using 

the silhouette of a cloud from 

a photo I shot during a walk 

in the park.”

21June 2018
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2DEPARTURE

“This is my vision of an 

interstellar journey about to 

begin. The space elevator is a 

kind of umbilical cord 

connecting the space station 

to Mother Earth.”

1STEALTH JET

“I did this to tweak my 

workflow between ZBrush, 

Blender and Photoshop.  

I drew inspiration from films 

to create a cinematic and 

atmospheric scene.”

Siddhartha Valluri

Siddhartha studied architecture before falling in love with game and film 

concept design. “I’ve travelled around India my whole life, which introduced 

me to a variety of cultures and architecture,” he says.

LOCATION: India MEDIA: ZBrush, Photoshop, Blender, Fusion 360, SketchUp  WEB: www.siddharthavalluri.com

Want to submit your work? Visit http://ifxm.ag/getinifx22 June 2018
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Want to submit your work? Visit http://ifxm.ag/getinifx 23June 2018

3

3CAPITOL COMPLEX

“The idea was to create 

an epic vista of a city with 

multiple points of interest, 

including the farmlands in the 

distance and a ring dividing 

the city into two.”



Strike a balance between 
art and social media
Sharing’s caring Can artists use social media without 
the platforms disrupting their work, asks Dom Carter

Likes. Retweets. Upvotes. They’ve all 

become common ways to gauge the 

popularity of our thoughts, and for 

those in the creative industries, our 

work. But are sites like Facebook, 

Twitter and Instagram a blessing  

or a curse for artists?

Just like any innovation, it all 

depends on how you use them. If 

you’re monitoring the performance of 

your latest status before you go to 

bed, it might be time to reassess your 

relationship with social media. 

However, when used right, these 

platforms can reap amazing rewards.

Despite the advantages 

of social media, Noah 

Bradley’s wary of 

prioritising it. “Every 

minute posting on 

social media is a minute 

that you could have 

spent painting.”

“I’ve discovered so many new artists 

who inspire me every day just from 

their social media posts,” 

says illustrator and Marvel 

comic artist Jen Bartel, 

who also uses social 

media to get her work in 

front of potential clients. “Working on 

comics often means working long 

hours in isolation, and finding those 

connections online is such an amazing 

lifeline for many of us,” she says.

For Art Camp founder Noah 

Bradley, social media has overtaken 

traditional routes to exposure.  

 Working on comics often means 
working long hours in isolation. Finding 
connections online is such a lifeline 

“I benefited from social 

media in building a 

fanbase for my work and 

connecting with fellow 

creators,” Noah says.  

“I think I’d have had a harder time 

becoming as well known as I am now 

without it.”

It isn’t all about business, though. 

For Sydney-based Wonder Woman 

artist Nicola Scott, living on the other 

side of the planet to where the rest 

“Keep some things to yourself,” says 

Nicola Scott. “People who follow  

my feed don’t have to know much in  

the way of specifics about my life.”

Jen Bartel strives to stay 

authentic online: “I figure 

most people follow me 

for the art, so I don’t 

want to overload them 

with personal stuff.”
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ARTIST NEWS, SOFTWARE     EVENTS

AT THE CORE OF THE DIGITAL ART COMMUNITY
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How do you juggle the 

personal and the professional 

on social media?

I keep anything personal to an 

absolute minimum, and I would 

never put photos of myself or my 

family on there. As much as 

possible, social media should be 

about the art.

How do you use social media 

and stay productive?

I don’t use Twitter on my phone 

so that’s not a factor. I don’t have 

any notifications going to my 

email if that’s what you mean. If  

I have a spare five minutes, and I 

feel like dipping in, I will. I don’t 

keep the Twitter window on my 

PC open at all times – that would 

be a risky mistake I think. I can 

resist anything except temptation, 

as they say.

What should artists not do  

on social media?

I don’t think there are any dos 

and don’ts specific to artists. 

Although, if you’re a working 

professional, it’s obviously not a 

good idea to tweet out artwork 

spoilers, so if I post ‘work in 

progress’ stuff, I try to make sure 

they’re non-specific images, or 

zoomed-in close-ups. 

If you want to avoid 

controversy then it’s probably not 

a good idea to get too outspoken 

about your own political outlook, 

as difficult as that is in the current 

political climate. That being said, 

it wouldn’t take too much of a 

genius to see that I’m a lefty 

liberal at heart, by looking at a 

few of my retweets.

INDUSTRY INSIGHT

Turns out there’s an etiquette for 
everything, including social media

Staz is an English professional 
comic artist who has worked 
on Batman, Spider-Man and 
2000 AD. 

https://stazjohnson.deviantart.com/

CELEBRATE 
THE MAGIC
To mark 25 years of 
Magic: The Gathering, 
artists created imagery  
with ‘vibrant renewal’  
in mind. Surprisingly,  
no one painted freshly 
baked birthday cakes.
Page 28

SPACE TO 
BREATHE
As well as containing 
digital and traditional 
workstations and a 
reference library, Jake 
Parker’s studio also  
has a space for daily 
meditation. Ommmm…
Page 30

GET A FREE 
ANNUAL!
Simply answer a few 
questions about the 
world’s best digital art 
magazine and we’ll give 
you a digital copy of the 
ImagineFX annual, 
worth £10! 
Page 34

STAZ
JOHNSON

Like many artists, Staz Johnson has 

benefitted professionally from social 

media. “I’m more visible as an artist. Offers 

of work have increased noticeably.”

25June 2018



Charles reasons that 

social media has 

changed the industry 

landscape for the 

better. “Compared to 

the amount of access 

artists have to the world 

now, that reality 

happened for only a 

handful of artists before 

the age of the internet.”

Noah thinks that artists 

have a unique 

advantage on social 

media. “The majority  

of folks on the internet 

consume media, so  

the ability to produce 

media is powerful.”

once it’s not attached to your body,  

or sitting in front of you at all times.”

However, there’s more to managing 

a social media presence than 

willpower alone. With online profiles 

blurring the line between where a 

person ends and their work begins, 

it’s important for artists to make clear 

the distinction between the two.

Jen uses her Twitter account for 

both work and fun, but errs towards 

the professional end of the spectrum. 

“I view social media as part of my 

job,” she says. “I also have designated 

times when I’m more active on it.”

Yet even the best intentions can slip 

after a while. For artists struggling to 

use social media constructively, there 

are a few options to consider. 

Scheduling updates through tools 

such as Hootsuite, TweetDeck or 

Buffer takes away the distraction of 

endlessly updating feeds. Users can 

simply plan their content in one batch 

and then check back in to take care  

of replies whenever suits them.

Another option is to set up a 

dedicated artist account across all 

platforms, while keeping personal 

profiles separate. This is a popular 

way to contain thoughts and opinions 

that don’t need to find a wider 

audience. Although a batch  

of accounts isn’t for everyone.

“That felt like way too much work 

for my taste,” says Noah, who decided 

to step away from social media 

completely. “It was a source of stress  

I didn’t need in my life.”

of the industry is located feels less 

isolating thanks to social media. “I get 

far fewer opportunities to meet or 

catch up with peers, 

mentors and fans,” Nicola 

says, “but through Twitter, 

Instagram and Facebook 

we can share in each 

others’ triumphs and slumps, promote 

and share our work.”

TAKING TIME OUT
Despite these benefits, freelance 

illustrator Charles Chaisson is keen to 

point out an important 

social media side-effect. 

“Social media prompts 

the release of dopamine, 

which is a chemical 

associated with pleasure in your 

brain,” he says. “I think it’s important 

to be cognizant of how that 

interaction affects us mentally.”

Like many users, Charles is limiting 

his time on social media in reaction to 

this. “What I tend to do is make sure 

that my phone is out of my line of 

sight,” he says. “It’s pretty easy to 

forget about checking your phone 

A love of work stops Nicola from getting 

distracted by social media, “I find it pretty 

easy to just not care what’s happening on 

Twitter while I’m not there.”
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It turned out to be a good choice 

for Noah, with the cost of online 

popularity worth less than emotional 

wellbeing: “I’m free to dive right into 

my creations. There’s no tickling 

feeling of social media at my back.”

ARTIST APPEAL
Artistic productivity isn’t always 

hindered by social media. In fact,  

the platforms provide a useful way  

to work out a draft. “Sharing WIPs 

with followers usually gives me a 

sense of how people will respond  

to the final artwork,” says Charles.  

“If you’re friends with a lot of artists, 

sometimes they’ll point out something 

that looks odd or needs to be 

tweaked that maybe you didn’t notice 

while working on the image yourself.”

“I love seeing other artists work,” 

says Nicola. “It can be fascinating  

to discover where and when an artist 

chooses to ‘finish’ their work.”

DRAWN TOGETHER
Even with their tendency to play with 

algorithms and change how users see 

posts, social media sites remain 

popular with artists. “Social media 

gives artists publicity that enable us 

to show our art to people around the 

world – which is pretty incredible if 

you think about it,” says Charles.

For artists, this publicity can be a 

revenue lifeline. “I think that just 

speaks to the fact that artists are 

 I love seeing other artists 
work, actually do the work, 
what their process is… 

“Posting frequency  

as an artist tends to  

be important if you’re 

trying to expand your 

following on social 

media,” Charles says.

being increasingly 

devalued in the internet 

age, so any potential 

revenue streams are 

worth exploring,” says 

comic book artist Staz Johnson.

Nothing’s perfect though, and 

following a recent migration of artists 

to the promising new pastures of ad-

free social media site Vero, Jen thinks 

a chronological timeline is what 

creatives are crying out for.

“Instagram’s new algorithms have 

hurt a lot of people and the minute 

there’s a comparable platform, they’re 

going to jump ship,” she says. “I’m not 

sure that platform is necessarily Vero, 

but fingers crossed something 

comparable will be released soon.”

Ultimately, Jen still thinks that social 

media can be a force for good. 

“Before social media, artists had to 

rely a lot more on getting their work 

published through official channels. 

Now we control how much content 

we put in front of our followers. 

Artist news, software & events
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Social media helps Staz to 

combat self-doubt. “It’s nice 

when people say good 

things about images 

you tweet, especially 

if it’s people whose 

art you admire.”

Internet popularity  

can be a double-edged 

sword, warns Jen 

Bartel. “The bigger your 

audience gets, the less 

you’re viewed as a 

human being.”



 We all care about making a 
great game, just like our artists 
care about making great art 

“Card art has many jobs 

to do,” says Magic: The 

Gathering senior art 

director Cynthia 

Sheppard. For the latest 

set the card art not only had  

to celebrate the game’s 25th 

anniversary, it also had to introduce 

characters and fit into a unique  

frame treatment for new card types.

Located on the plane of Dominaria 

– home to a wide variety of ecologies 

Magic marker Visit the plane of Dominaria in the latest Magic: The Gathering  
set that salutes the trading card game’s past, present and exciting future

Celebrating 25 years of 
Magic: The Gathering

and terrains – the illustrations in this 

set relied on Magic’s detailed world 

guides to capture a specific visual 

identity. “‘Vibrant renewal’ was one 

key theme in Dominaria,” Cynthia 

explains, “and one way that was 

expressed visually was by showing  

the plane during springtime.”

Orchestrated by senior art director 

Mark Winters, the art in Dominaria 

features work by Jenn Ravenna, 

Manuel Castañón and Magic’s in-house 

graphic designer James Arnold, as 

well as Magic: The Gathering: Masters 

25 artist, Jehan Choo. “We look  

for artists who demonstrate great 

craftsmanship,” says Cynthia, “and 

who can illustrate things that don’t 

exist in real life… and make them  

look awesome in a two-inch box.”

Cynthia pinpoints the one trait  

that’s contributed to the card game’s 

success. “It’s passion – we all care 

deeply about making a great game, 

just like our artists care deeply about 

making great art.”

Visit https://ifxm.ag/dominaria  

to see more art from Dominaria. And  

if you’re interested in working for 

Wizards of the Coast, the publishers  

of Magic: The Gathering, then learn 

how to submit your portfolio by 

visiting https://ifxm.ag/wotc.

 “First and foremost, the art  

needs to be an appropriate  

visual representation of the card 

mechanics,” says Cynthia Sheppard.

Magic art has evolved alongside its artists, gameplay, 

and the fantasy illustration community,” says Cynthia.

Magic writers and artists work 

together to clearly illustrate 

in-game visual metaphors, 

such as drawing a card or 

countering a spell.

“Magic doesn’t have a 

house style,” says 

Cynthia, “though most 

card art is centred around 

imaginative realism.”
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Visual information about 

environment, people, creatures 

and motifs are all recorded  

in Magic’s world guides.

World guides help a card 

set to feel cohesive, while 

enabling artists stay true 

to their individual styles.

A new card type, called Saga, plays along a  

linear narrative and features vertical illustrations.
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Jake 
Parker
Creatively engaged From 
illustrating to studying, 
every aspect of this artist’s 
studio is designed for a 
smooth flow of work

I’ve got a 120-square 

foot corner of a larger 

office space, and I love 

it here. It’s located 

about 15 minutes from 

my house, in downtown Provo, Utah, 

which gives me just enough time to 

decompress during my commute. 

I designed my workspace for focus 

and productivity. For example, when 

I’m illustrating I don’t want to be 

distracted by emails or Twitter, so I’ve 

put my computer on the opposite side 

of my drawing desk.

In keeping with the theme of focus  

I’ve divided the space into three 

sections. The first is my computer 

station. Here I have an oldish (2012) 

iMac and an even older (2007) Wacom 

Cintiq that’s running Adobe CS6 

software and my favourite program for 

making comics: Clip Studio Paint. 

TALKING PICTURES
I have a mic hooked up to my 

computer that I use to record audio for 

my podcast and YouTube videos. The 

left side of my computer station is 

where I keep my reading library and 

where I write my daily journal, study 

and meditate. The drawers that are 

beneath the table house art supplies 

and original art. 

The second station is my reference 

library. I collect art books and graphic 

novels. My philosophy on book buying 

is that if it can help me become 

I think if you want to separate yourself 

from the noise that’s out there from 

everybody else saying, “Hey, look at me! 

Look at me!” then you have to take on a 

personal project, and put something 

uniquely yours into the world.

ImagineNation Artist in Residence
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 My office is located 
about 15 minutes from 
my house, which gives 

me just enough time 
to decompress during 

my commute 
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more creative or better informed 

on the craft of illustration and comics, 

then I buy a copy. Although I don’t 

read every book regularly or 

consistently, it’s nice to have them 

there in case I find myself in a pinch, 

and need fresh ideas for a project. 

The books are organised by type.  

I have a section for foreign graphic 

novels, domestic graphic novels,  

how-to books, artist specific art books, 

animation art books, film/video game 

art books and sketchbook collections.

MAKING LIGHT WORK
To the left of my reference library is my 

drawing desk. I’ve positioned it to the 

right of the window so the natural light 

doesn’t cast a shadow over my 

drawing hand. I keep the table flat so  

I can put plenty of reference books 

around me. On top of the drawing 

desk is a “My Drawing Board” from 

France. This enables me to work 

upright, which saves my back from 

unnecessary strain. 

To the right of my desk is another 

set of drawers. I keep my pencil 

sharpener, markers and brushes on the 

top for easy access. Inside the drawers 

are more art supplies.

The main thing I love about this 

space is the natural light. I worked for 

over a decade in a basement, so it’s 

nice to finally see the light of day while 

I draw! All in all, it’s a great space that 

gets me pumped creatively every time 

I sit down to work.

Jake is an illustrator and cartoonist with 

several graphic novels and over 10 picture 

books to his name. For 12 years he worked 

on several animated feature films and other 

productions before pursuing a career as an 

independent artist. He launched Inktober in 

2008. See his art at www.mrjakeparker.com.

This wall is where I keep a schedule and 
ideas for future projects. I like to be able 
to refer to the schedule quickly, which is 
why it’s nearby and easily visible.

Many years ago I switched to a stool 
instead of a chair. This keeps me from 
slouching and helps me move back 
and forth between stations better.

I like to keep images on my walls that inspire me. 
Many are small prints I’ve picked up at conventions, 
but there are a few original art pieces that I’ve 
traded with other artists.

My wife got me this Eiffel Tower lamp almost  
20 years ago. It’s been a fixture in every studio I’ve 
worked in. I love its warm light; it reminds me of her.

I’m a huge fan of Copic markers, but  
I can’t take all of them with me when  
I’m out of the studio, so I carry a mini 
watercolour set and a small bag of pens.

I grew up spending days playing with 
LEGO, building little worlds in my 
bedroom. Recently I made a LEGO version 
of my comic character Skull Chaser.

ImagineNation Artist in Residence
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The images in front of my drawing are 

reference images for the current 

project I’m working on. These images 

are changed out pretty regularly.

The university in my town was 

getting rid of these book shelves 

so I snagged them for $30. It’s 

the best $30 I’ve ever spent.

My library editions are cherished 

treasures. Bill Watterson, David Roberts, 

Mike Mignola and Ralph McQuarrie have 

all been hugely influential in my work.

 I worked for over a decade 
in a basement, so it’s nice to 
see daylight while I draw 

Next to the National 

Geographics is my growing 

collection of Inktober books 

people have self-published and 

sent to me. I love seeing what 

people do with the challenge.

I’ve had a subscription to 

National Geographic for 

almost two decades. I find it 

to be a never-ending source 

of inspiration for characters, 

locations and situations for 

my comic stories.

I keep this Admiral Ackbar figure 

right next to my monitor to remind 

me to avoid traps, like spending too 

much time surfing the web.

Artist news, software & events

33June 2018

I try to tell little self-contained stories in my drawings. My hope is that the viewer is taken somewhere when 

they look at a piece. I want them to know what happened before this image and what happens next.

I like combining things that you wouldn’t 

think to put together. I do this creative 

exercise before I sit down to draw. Now you 

know how this mecha-squid happened! 



Every issue, we do our 

best to create a magazine 

that inspires you to make 

art. But we’re always 

looking for ways to make 

ImagineFX even better, so we’d like 

your help. To receive your free digital 

edition of the Annual, all you need to 

do is answer some quick questions 

about yourself and the magazine. We 

look forward to hearing from you!

Claire Howlett
Editor

After completing 

the survey, 

you’ll receive a 

digital copy of 

the ImagineFX 

Annual as a  

thank you for 

your feedback.

FREE ImagineFX 
Annual worth £10!

Complete our reader survey at 

http://ifxm.ag/ifx-reader-survey
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The traditional vs digital 
art debate rages on…
In response to the question on 

whether we’d like to have more 

traditional artwork in ImagineFX,  

I have to agree with the reader in the 

April issue. I buy the magazine 

because I want to improve my skills in 

digital painting. I do love the 

combination of articles about digital 

painting, 3D, traditional and so on 

because there’s always something I can 

learn from it. But in the end, my interest 

doesn’t lie in traditional art. ImagineFX 

should keep its main focus on digital 

art. The amount spent on traditional art 

is just about right for me.

Laura Heuijerjans, via email

Claire replies I hear you, Laura! Despite 

being a digital artist, you’re happy with  

the current level of traditional art content  

in the magazine. I took the decision to 

include traditional artists in ImagineFX 

because I felt that we were excluding a  

rich seam of talent who could bring so  

much to our magazine. I also saw that  

lots of digital artists were experimenting 

with traditional methods, so I felt that I 

should explore a broader scope of mediums 

within our pages.

When I first began buying ImagineFX, 

six years ago, I was dedicated to digital 

art. Every issue that came through my 

door was a wonderful treat, full of 

inspiration and new things to try. But 

over time I became much more 

traditional – the digital nut who first 

bought ImagineFX wouldn’t recognise 

the artist I am today! But I still savour 

every issue, and this is mostly due to 

the inclusion of traditional art. 

The traditional art section gives a 

focus to an underrepresented section of 

fantasy art. Its cutting, or total removal, 

would alienate a portion of your readers 

and reinforce the misconception that 

good fantasy art is only ever digital. I 

hope to submit my work very soon, as a 

dedicated mixed media artist.

Morrighan Corbel, via email

Claire replies Thank you, Morrighan. I 

like to think that by reading ImagineFX, 

readers will get a taste of other art forms and 

styles, which will only enrich their 

endeavours. Lots of artists use mixed media, 

and I feel it would be a shame not to include 

these artworks.

I wanted to weigh in on the debate 

about traditional art versus digital art. 

First, an understanding of perspective, 

anatomy, lighting, colour and 

composition are of benefit to all artists 

regardless of their medium of choice. 

There’s much to be learned from seeing 

how others approach their art that can 

be transferable to other mediums.

Let’s also not forget Bob Ross was 

doing speed painting with his wet-on-

wet oil painting technique well before 

digital speed painting was possible. I’d 

be fascinated to see how today’s digital 

artists, more commonly associated with 

‘speed painting’, might tackle the same 

kinds of subject matter as Bob.

How about taking a single subject 

and seeing how Bob Ross, or another 

traditional artist, would have tackled it. 

Then go on to show how digital artists 

can utilise tools available to them to 

also produce detailed paintings in 30 

minutes or less. I think it would be 

fascinating to compare different 

approaches leading digital artists would 

use now, and compare the results.

Jonathan Harley, via email

Claire replies. I agree, Jonathan – 

regardless of the medium you choose, you still 

have to master the basics of art. I hope that 

we deliver this as a package.

In issue 160 Dustin Nguyen painted this comic cover 
using watercolours with a touch of Photoshop. 

Contact the editor, Claire Howlett, 
on claire@imaginefx.com or write 
to ImagineFX, Future Publishing, 
Quay House, The Ambury,  
Bath, BA1 1UA, England
Follow us on Twitter: 
www.twitter.com/imaginefx

Tell us your thoughts on Facebook: 
www.facebook.com/imaginefx

Post your art or photos on Instagram: 
www.instagram.com/imaginefxmagazine

YOUR FEEDBACK & OPINIONS

We think featuring 
traditional artists is a 
great way to get insights 
and advice on different 
art techniques, as well as 
a more balanced view of  
the industry.

DID YOU MISS 
THE PREVIOUS 
PACKED ISSUE?  
Don’t worry – you 
can still get hold 
of it. Visit http://
ifxm.ag/160-ifx 
for details.

35June 2018

Letters

If you have created art that you want us to 
shout about simply tag us on Twitter or 
Instagram, or find us on Facebook! 

New works that have 
grabbed our attention

 Kellie Marks 
@hellcat_illustration

 Carlos Suñé 
@carlos_sunye

 Patrick Jones  
@pjartworks
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PROFILE
Allen Williams

Location: US

Favourite artists: John Jude 

Palencar, Hans Bellmer, Frank 

Frazetta, HR Giger, Zdzisław 

Beksinski, Andrej Dugin  

and Olga Dugina

Media used: Pencil, graphite, oils and acrylics 

Web: www.allenwilliamsstudio.com

llen Williams moved around a 

lot when he was younger. A 

month here, six weeks 

there. In total, he attended 

more than 20 high schools. 

His dad’s job meant they were often 

on the road. They lived in small rental 

apartments or hotels, Allen’s “most 

relied-upon distractions” became 

reading and drawing. “The easiest 

things to come by were paper and 

pencils,” the artist says. “They were 

nomad-friendly endeavours. I think 

the immersion into various genres of 

fiction coupled with the fact that I 

travelled so much combined to make 

me someone who spends a lot of time 

in my own world.”

And what a world. Allen’s art comes 

crawling off the page at you: weird 

monochrome figures, the human and 

the human-like. Something is 

Allen Williams
The American illustrator and concept artist tells Gary Evans how he 
teases out imagery from his subconscious using prose and poetry

FALL OF NIGHT
“I had an idea of the 
piece’s direction from  
the start. It grew from  
the centre out and  
I used graphite on 
Stonehenge cream  
spiral journal paper.”

Interview Allen Williams
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FOREGONE KINGS
“This piece is part of a larger 

story of mine. The story revolves 
around a young girl who’s learned 

how to awaken the giants of the 
Earth, the Thirteen Kings.”

´



always going on in his work, some 

story simmering away under the 

surface. Maybe a bit of free association 

too. Perhaps it’s something in his 

subconscious that sees all those weird 

faces staring out at him from the 

graphite dust that he piles on to the 

page. His job is to tease them out.  

The result is occasionally dreamy, 

fantastical, but more often than not  

it’s dark and unsettling. Allen believes  

his love for this dark world is a fire 

illuminating it. 

THE COLLEGE DROPOUT
Allen got into comic books before he 

could read. He remembers staring at 

the pictures for hours at a time. Long 

after becoming a capable reader, he 

continued to follow the stories through 

the pictures alone. 

He liked horror and read William 

Peter Blatty’s The Exorcist when he was 

seven. Allen found even the most 

horrific of horror plots “much less 

worrisome” than real life. He also 

trained in martial arts, specialising in 

the Shotokan style of karate. “It made 

me less… breakable. I loved to fight 

when I was younger.”

He never considered making a career 

out of art. He went to college as a 

business major – which lasted one day. 

He took the pre-entrance creativity test 

at the small community college and 

received the highest score of all first-

year students. One of the college 

counsellors suggested that he should 

have a word with the art teachers. 

Allen switched to a larger university, 

where he felt out of place in fine art 

classes, but got on well in illustration. 

He started to secure freelance work and 

steadily build up a portfolio. Someone 

told him nobody ever asks a freelance 

illustrator where they went to school. 

So he quit.

“The only people who usually ask 

where I went to school are students,” 

he says. “Most of what I’ve learned has 

been through trial and error, 
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 Trail and error’s taught me a lot. If 
there’s something I want to know, I’ve 
become good at Googling 

GAUNT QUEEN
“This began as a gestural sketch 

that developed first in acrylic, then 
in oil. Beneath the final image there 

are two previous attempts that  
I didn’t feel were working.”

OCCULTATION
“I did this with graphite and oil on 
board. It was an effort to push my 
graphite wash process to a larger format.”
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FINDING 
YOUR 
VOICE
Allen Williams explains 
how his unique art style 
comes from deep within

“I’d say my work is an exploration 

of my subconscious – at least, at 

the beginning. My conscious mind 

does eventually take the lead, but 

that’s usually after I’ve started the 

process. I feel like you might 

describe my work as organically 

directed growth. In the past, I’ve 

equated it to a graphite virus, 

infecting the paper. 

I usually have a narrative that 

starts developing, assembling itself 

as I go along, and frequently a 

written narrative accompanies the 

work. I’ll often use words in this 

narrative that I don’t know, but 

they sound correct, and when I 

have later done the research, they 

end up having a meaning that 

works – likely, because I’ve read so 

much that I’ve come across these 

words and phrases and forgotten 

them. Or it’s magic. That works for 

me, too. 

For my illustration the Stillborn 

King, I wrote the following piece of 

prose: ‘He is borne from the 

broken heart of the world / He 

draws close / The Dread walker / 

The Stillborn king / The Unarmed 

man / Set in opposition to the men 

of violence, the men of pain / And 

their mouths shall be filled with 

molten lead.’

A common theme in my work, 

which many miss, is the idea that 

beauty doesn’t equal good and the 

grotesque isn’t an indication of evil. 

The same with dark and light: there 

are as many wretched things that 

happen in the day, as in the night, if 

you’re paying attention. Many of 

the beings that inhabit my imagery 

are guardians of a sort, such as the 

Stillborn King.

I use visual metaphors to combat 

the violence I see. As an artist, it’s 

one of the ways I speak against it. 

This happens frequently in my 

personal work. I think, as an artist, 

it’s best to just do what you want, 

as well as you can, and let others 

decide how they want to define it 

for themselves.”

THE STILLBORN KING
“At the time, this was one of my largest 
drawings. I developed it in pencil from 

a series of sketches and false starts.”



seeking out focused seminars, such 

as the Illustration Master Class, and if 

there’s something specific I want to 

know, I’ve become good at Googling.” 

Allen started full-time as a freelancer 

in 1988. In those days, he found it hard 

to get his work in front of the right 

people. And when he did, it didn’t pay. 

Some jobs he earned just $10. “I’d do 

just about anything,” he says. “I guess  

I was willing to pay my dues.” 

He remembers a commission on a 

game, Car Wars: “They wanted 

mounted gun turrets on cars, all done 

with believable proportions – perfectly 

reasonable expectations for that kind 

of game, but it just wasn’t me.”

He stuck at it. Better jobs eventually 

found him. This sort of persistence is 

essential: as a freelancer, if you keep 

going long enough, eventually there’s a 

snowball effect. More work, better 

jobs. A bit of luck helps. And you need 

to put the effort in, too. But the 

struggle can be beneficial: “I like to 

40 June 2018

Legend

KITH
“This piece was a representation of 
my frustration with current events 
and the tendency to exclude those 
whose differences make them targets.”

THE LOTUS KING
“He actually started out as a sketch 

about something else entirely, but with 
personal work, I always allow myself 

to follow the idea if it’s working.”

HAND OF THE MOTHER
“This piece began with a narrative 
about a mother seeking vengeance, 

and that informed the drawing.”



say,” Allen says, “I’ve never been cursed 
with early success.”

Allen enjoyed freelance jobs for  
card game Magic: The Gathering,  
toy company Hasbro and publisher 
Tor, but he soon realised that most 
“contract work” didn’t suit him.  

It wasn’t until his son was born  
in 2002 that Allen started to take his 
work seriously: “I discovered very 
quickly that if I didn’t have a work 
ethic, a routine, I’d never get anything 
done, or not enough anyway. My 
output, my speed, increased 
exponentially after that.”

ADDICTIVE FILM WORK
It paid off in 2010 when Allen got a 
concept artist job for the director 
Guillermo Del Toro (Pan’s Labyrinth, 
Pacific Rim, The Shape of Water). The 
film never came out. But Allen found 
out how exciting – and stressful – it 
was working in the movies. He was 
hooked. He went on to work on several 

more films, including Darren 
Aronofsky’s Noah. 

Allen felt restricted by freelance jobs 
early in his career, but while working 
with people like Del Toro and 
Aronofsky, he learned to work with 
those restrictions rather than fight 
them: “To do contract work means  
that you understand your personal 
narrative may not be applicable to  
their story. Stylistically, process has  
to accommodate levels of approval.  
I can’t just start and finish. I need the 

director or production manager to be 
involved to ensure the direction is 
appropriate to the film. There are times 
when it’s in perfect alignment with 
what I’d have done for myself, but you 
can’t be too attached because often it’s 
not and needs to be tweaked to fall in 
the right groove.”

IT’S LIKE EATING 
A piece in graphite takes Allen between 
three days and three weeks to 
complete. It depends on the size 

Interview Allen Williams
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 I discovered very 
quickly that if I 
didn’t have a work 
ethic, I’d never get 
anything done 

AETHER
“An exploratory piece in powdered 

graphite, pencil and oil, where  
I made shapes and nudged them  
into representational elements.”

WORMWOOD 
PRINCE
“The narrative for this 
piece begins: ‘I was  
born in the heart of the 
fire that made the sun… 
all suns.’ It’s a small 
graphite piece of another 
guardian-type figure.”



THE MOON THIEF
Allen explains how he pushes and pulls 
an image from some graphite powder

“For this particular piece I started with a panel  

of Ampersand claybord. Initially, I took a damp magic-

eraser sponge and used it to spread graphite powder 

about on the board until an interesting rhythm of 

shapes and textures emerged. I pushed and pulled  

the shapes using the damp sponge to lift up the 

graphite and move it around.

Once I was satisfied with the rhythm of the elements  

I started to define them by picking out and rendering 

little bits and pieces here and there. It’s at this point  

the idea of a face come through. 

I could see that the texture started to take shape,  

but the piece as a whole was still developing. I started 

placing the areas of a face by lifting out the highlight 

with a kneaded eraser, abrasive pencil-type eraser,  

and a small Sakura electric eraser. I further defined  

the facial features by drawing into it with very soft 

leaded pencils – 4B-10B.

To balance the composition I added a hand shape 

that was posed in the manner that you can see in the 

finished piece, but I still had no idea about what she 

might be holding, which would solidify the narrative. 

Then I was listening to the news while working and 

heard someone say the words: ‘They’re stealing from 

us. It’s not fair.’ It was then that her narrative self-

assembled in my head. It became: ‘You have taken  

what does not belong to you. Five days hence I will  

take the Moon.’ That’s where the crescent moon idea 

came from. 

I placed the crescent moon in the piece using the 

same additive-subtractive technique. I made a crescent-

moon cut-out to use as an eraser shield and to create 

precise edges, a coat of spray gloss, acrylic-crystal, 

clear-type varnish, and I’m done.”

WORKSPACE
Allen’s desk is often 
“littered with almost any 
pencil you can imagine.” 
His favourites are the 
Tombow Mono 100  
4B and Uni Mitsubishi 
Hi-Uni 10B.  

WORK IN PROGRESS
Allen can spend as long  
as three weeks on a  
single pencil drawing 
“depending on its size  
and complexity.”

POEM
Many of Allen’s pieces 
begin with a prose-poem 
narrative in which he 
introduces us to the story 
world and its characters.
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THE MOON THIEF
“I did this for an online 

gallery and, again, I was 
pushing the control of the 

chaotic medium on a small 
scale. I did this piece with 

powdered graphite and pencil 
on Ampersand claybord.”

Interview Allen Williams

43June 2018



and the complexity. His favourite 

materials are the Tombow Mono 100 

4B and Uni Mitsubishi Hi-Uni 10B 

pencils, graphite powder and kneaded 

erasers, usually on watercolour paper.

Paintings take longer. He likes Acryla 

gouache acrylics and Liquitex and Old 

Holland oil paints. He collects 

references, keeps sketchbooks, and 

journals. “Sometimes I’m just along  

for the ride and the piece is driving, 

other times I know where I want to go. 

I allow myself that freedom with 

personal work.”

Freelance jobs need a bit more 

planning, more of a fixed routine. And 

family stuff comes first. After living in 

over 40 states, he’s now settled on the 

Gulf Coast with his wife, children and 

dogs. His studio door is always open 

and his son and daughter like to work 

in there with him. But generally, if 

Allen’s awake, he’s working. 

When he was younger, art was a 

distraction. It took him a long time to 

turn that distraction into a discipline. 

And drawing still seems to fulfil some 

need. It’s a necessity. He compares it to 

eating: he has to do it. Somewhere 

along the way, Allen Williams 

developed that thing every artist wants, 

the thing separates good art from great 

art: a voice of his own.

Allen’s ‘voice’ will be seen at his first 

solo show in July, at the Copro Nason 

Gallery in Santa Monica, California. 

He’s also working on his first art book, 

The Book of Covenants, which he will 

Kickstart in the spring of 2019. Exciting 

times lie ahead…

“Great art feels like someone 

punched you in the brain,” Allen says. 

“It drags you back to the museum or 

the gallery or the page of the book. You 

have to right-click and save and you’re 

frustrated if you can’t. 

“If you’re an artist then it isn’t just 

the how or the why, but a wordless 

thing that feels both like something 

you may have dreamt and something 

you’ve never seen, but on some level 

you understand. It’s more than the 

sum of its parts.” 
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 Sometimes I’m just along  
for the ride, and other times  
I know where I want to go 

THE BIRTH OF DEATH
“Here I was pushing a 
more wilful control into 
the process, which 
sometimes doesn’t end 
well, but this time it  
was agreeable.”

THE HOBB
“This is an expression of 
dissatisfaction with the 
current political climate.”



Interview Allen Williams
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THE CROOKT MAN
“‘Stand thee well away o’ wolf. 
This Shepherd does not sleep.’ 
Another guardian figure, where 
I mingled realistic elements with 
more abstract shapes.”



Make your mark in the book 

industry, with pro advice from 

Wylie Beckert, Dave Kendall and 

Armand Baltazar. Illustrator Sam 

Weber talks about emotions, and 

we find out how fan art can lead 

to getting paid work.

Pro artists from the video games 

industry pass on their advice on 

character design, weapon 

concepting and environment art. 

We also talk to Assassin’s Creed 

visionary Raphael Lacoste, and 

Bungie’s AD Jesse van Dijk.

Boost your anatomy drawing 

skills with Stan Prokopenko’s 

tips. We talk to fantasy figure 

artist Julie Bell and soil scientist 

turned sculptor Romain Van den 

Bogaert. Plus, what it takes to 

launch a successful Kickstarter!

Issue 157 
February 2018

Issue 159 
April 2018

Issue 158 
March 2018

Comic artists assemble within 

this month’s issue! We speak to 

Ken Lashley and Tony S Daniel, 

reveal how to draw expressive 

faces for your panel art, and then 

colour it effectively. Plus, how to 

beat back negative thoughts.

Issue 160 
May 2018

Complete your collection!
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 www.bit.ly/ifxbackissues

Back issues
Missed an issue of ImagineFX? Don’t panic,  

here’s how you can order yours today!

BUY PRINT EDITIONS  
OF IMAGINEFX AT:

Only the  
most recent 
editions are 

available in print 

WHILE  
STOCKS  

LAST!

Missed out on a recent print edition of ImagineFX?
See what’s available at www.bit.ly/ifxbackissues.

Got an Apple iPad, iPhone or iPod Touch?
Get the free ImagineFX app for your iPad or iPhone  

at http://ifxm.ag/apple-ifx, or download us straight  

from the Newsstand app already on your device.

On Android, PC or Mac?
Google Play: http://ifxm.ag/google-halfprice 
Zinio: www.bit.ly/r938Ln

Got some other device?
ImagineFX is available for all kinds of  

devices, including Barnes and Noble’s nook,  

and Amazon’s range of Fire tablets. 

PRINT AND DIGITAL BACK ISSUES



RESOURCES ARE INCLUDED WITH PRINT AND DIGITAL EDITIONS*

GET YOUR DIGITAL EDITION 
THROUGH THESE OUTLETS:

Issue 145 

March 2017
Issue 147 

May 2017
Issue 146 

April 2017
Issue 148 

June 2017

Issue 149 

July 2017
Issue 151 

September 2017
Issue 150 

August 2017
Issue 152 

October 2017

Issue 156 

January 2018
Issue 153 

November 2017
Issue 155 

Christmas 2017
Issue 154 

December 2017

NOW ONLY AVAILABLE AS A  

DIGITAL EDITION

Back issues
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PROFILE
Tobias Kwan
LOCATION: Canada

Tobias is a freelance 

illustrator and concept 

artist from Ottawa. He 

studied animation at 

Sheridan College before 

moving to California to work in video 

games. He now lives and works in  

New York. Tobias’ clients include 

Amazon Publishing, Sony Music Japan, 

Riot Games, Ready At Dawn Studios, 

Games Workshop, Cartoon Network, 

Sideshow Collectibles, Oakley, Li Ning, 

Chair Entertainment and Mattel.

www.tobiaskwan.com

Disturbing intertwining elements share page space alongside 

delicate portrait pieces in this New York artist’s sketchbook 

 Bit of a horror vibe  
going on here... She’d have 

trouble with enunciation 
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LADY 
“I tend to draw these 

kooshballs in areas 

where I can’t think  

of something 

interesting.”

SEIFUKU
“This was a 

tattoo design for a 

buddy of mine. 

Hope it turned  

out okay!”



Sketchbook Tobias Kwan
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HELPING 
HANDS

“Did this for last year’s Inktober challenge. 

There’s a bit of a horror vibe going on 

here. Looks like she would have 

trouble with enunciation.”



  I’ve been trying 
to do more oil 
sketches. The 
biggest hurdle is 
getting started… 
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SPACEMAN 
“Just doing the usual 

tentacle thing I like to do 

here. I’ve always loved  

the aesthetic of early 

spaceflight suits.”



Sketchbook Tobias Kwan
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INKTOBER 
28

“This is pretty comfort 

zone stuff for me here: 

multiple limbs, tentacles, 

flowery bits of detail  

to help separate out  

the forms.”

DRESS
“Here I tried 

incorporating some 

Gothic architectural 

motifs, but mostly I was 

just scribbling in shapes 

and seeing where  

it takes me.”

FEATHERHEAD
“An oil sketch. I’ve been trying to 

get in the habit to doing more  

of these. The biggest hurdle  

is just getting started.”



 I find it’s rather 
therapeutic to just 
turn off the brain 
and fill in the  
blank spaces 

FLOWERHEAD 
“Is this the kind of bedhead you get from 

sleeping in a pile of flowers?”
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HORSE  
“A horse of sorts with hands 

for feet. I really can’t explain much 
more. There’s probably some 

Freudian/Jungian thing going on here 
that I don’t want to know about.”

WITCH
“Just a witch doing her 
thing. I drew this after 

watching and really loving  
the 2015 film The Witch:  

A New-England Folktale.”



Do you want to share your sketches with your fellow ImagineFX readers? Send us an email with a 
selection of your art, captions for each piece and a photo and bio of yourself to sketchbook@imaginefx.com

Sketchbook Tobias Kwan
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CATBURST  
“I tend towards organic shapes, 

but I also suck at freehanding 

straight lines.”

 
INKTOBER 03 

“For pieces like this, I find it’s 

rather therapeutic to just turn 

off the brain and fill in the  

blank spaces.”



PROFILE
Daria Theodora
LOCATION: US

Daria’s works feature 

delicate hand-drawn ink 

drawing, to which colours 

are applied digitally or 

traditionally. She was a 

gold medallist in the Gallery category 

of the Society of Illustrators of Los 

Angeles’ (SILA) 56th competition, and 

has been featured in Spectrum. In her 

spare time she enjoys leisurely strolls 

in the woods, biking and travelling.    

www.xintheodora.com

This illustrator uses her sketchbook for visualising her ideas. Even if 

they remain there as rough drawings, the art is worth exploring… 

 Some of my ideas sit 
in the sketchbook for  
a long time before I get 
to pick it up again 
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WARRIOR 
AND CAT

“I very much admire  

Sergio Toppi for his use of 

lines in his illustrations. This 

drawing was one of many 

mark-making exercises 

using Sergio’s art  

as reference.”

EXPLORATION 1
“I produce many sketches 

to generate ideas for my 

next painting. Some sit in the 

sketchbook for a long time 

before I get to pick it  

up again.”



WELCOMING 
DUSK 

“The fantastic Mr. Fox 

(well, sort of) and an  

ornate lantern.”

Sketchbook Daria Theodora
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 Just a doodle while 
travelling, using a fountain 
pen and watercolour 

TRAVEL 
SKETCHES

“Just a doodle while 

travelling, using a fountain 

pen and watercolour in my 

Moleskine sketchbook.

 
EXPLORATION 2

“A pencil drawing when sitting 

in a café drinking coffee.” 

BIRDS
“Part of a fun project, drawing 

a bird’s skeleton and birds 

in flight.”
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CORMORANT 
STRIKES

“A literal take on Cormoran 

Strike, my favourite series 

from JK Rowling (writing 

as R Galbraith), that’s 

not Harry Potter.”

Sketchbook Daria Theodora
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MISCELLANEOUS 
WONDERS

“Where necessary, and 

especially when doing a big, 

complicated illustration, it’s easier 

to draw each component 

separately, then rearrange their 

placement digitally.” 

MOUNTAIN GOAT
“When drawing from reference, I try to 

take the art into my own style while  

making sure that the result is  

still recognisable.”

MISCELLANY
“Here are some more 

components from this 

sketch project. I had to make 

sure I kept a steady  

hand to draw the  

clean lines.”
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Do you want to share your sketches with your fellow ImagineFX readers? Send us an email with a 
selection of your art, captions for each piece and a photo and bio of yourself to sketchbook@imaginefx.com

 When drawing 
from reference, I try 
to take the art into 
my own style 

MELANCHOLIC 
SHUT-IN

“Here’s the base of a 

piece, before my paints 

obscure everything.”

HIDING 
IN LAYERS

“Here’s an Inktober 

drawing that was 

supposed to be quick, 

but ended up taking  

me hours!”

 
MAKKUROKUROSUKE

“A sort of fan art of My Neighbor Totoro, 

a must-see Studio Ghibli feature.”

Sketchbook Daria Theodora

59June 2018



The number one destination 
for digital art news,  
views and how-tos

www.creativebloq.com
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Web design   
    

3D   
    

Digital art



GET YOUR 
RESOURCES

See page 8 now!

This issue:

Advice from the world’s best artists

Workshops assets  
are available…

Download each workshop’s resources by turning to  

page 8. And if you see the video workshop badge,  

you can watch the artist in action, too.
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82
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62 Learn to paint  
a surreal portrait
Erik Jones takes abstract 
shapes and transforms them 
into stunning character art.

68 Revisit Beksinski’s  
surreal world
Rafael Sarmento pays tribute 
to one of the 20th century’s 
most inspiring surreal artists.

74 Paint a corpse 
that’s full of life
Peter Polach attempts to 
elevate the mood of a 
traditionally grim topic.

78 Core Skills: 
Photoshop
Mark White uses Layer Styles 
to improve his art and shows 
how to layer them effectively.

82 Streamline your 
costume designs
Paul Gerrard treads the fine 
line between concept art and 
workable costume designs.

´



LEARN TO PAINT A 
SURREAL PORTRAIT
Straddling the worlds of traditional and digital art, Erik Jones takes 

abstract shapes and transforms them into a stunning character piece

I’m a traditional 
painter who regularly 
uses digital elements 
as a tool throughout 
my creative process.  

In this workshop, I’ll take you 
through the digital techniques I use 
when overlaying elements on top of a 

traditional figure painting. I’ll also 
explore how traditional and digital 
painting can meet seamlessly 
through a series of very easy steps. 

For this process you’ll only need  
to know the basic functions of 
Photoshop. The trick is to keep it 
simple and let the program do most 

of the work, such as gradients,  
colour adjustments and transparent 
overlays. Most of the hard work  
is done before you get to the digital 
part. I’ll also show how I stitch 
together large paintings. This, too,  
is accomplished by letting Photoshop 
work its magic. Let’s get going! 

1
Produce a pencil sketch
Like most art projects, I’m starting with a sketch. My 

sketches are more like large thumbnails. I’m looking to get 
a basic layout of the figure and the shapes. I almost never 
add details of any sort – this will come when I digitise the 
sketch. I work with two pencils: a light blue pencil for 
light lines and a bark brown pencil to solidify shapes.  
I usually use a scanner to digitise the drawing. However,  
my scanner has just bit the dust, so I’m going to use my 
digital SLR camera. You can also use your camera phone.  

2
Create a clean line drawing
Once my sketch is in Photoshop I open a new file at 

the size required, transfer the drawing to this file and then 
begin to create a clean line drawing on top of the loose 
sketch. I can then trash the loose sketch. My aim is to print 
the clean line drawing on to watercolour paper. I need the 
lines to be light and soft so that they don’t show through 
when I’m painting traditionally. To do this I colourise the 
lines to a light brown colour. Next, I duplicate the layer 
and add a Gaussian blur to the top layer (Filter>Blur> 
Gaussian blur). Then I reduce the Opacity of the bottom 
line layer. Now it’s ready to print. 

Traditional skills & Photoshop

GET YOUR 
RESOURCES

See page 8 now!

Erik Jones
LOCATION: US

Erik’s a figure and 

abstract mixed media 

painter. He works on 

paper and wood with 

materials such as 

watercolour, pencil, wax 

pastel, acrylic and oil. 

www.erikjonesart.com

Artist

 PROFILE

PANEL

In-house made, 1.5-inch 

birch wood panel  

PAPER

Legion Paper Lenox 100 

(250gsm)

PAPER ADHESIVE  

Golden, Gel Matte 

Medium

WATERCOLOURS

Winsor & Newton: 

Cadmium yellow hue

Cadmium red hue

Intense blue

Burt sienna

Chinese white

COLOURED PENCIL 

Prismacolor pencils  

in assorted hues

PAINT

Acrylic latex paint in 

studio colour mix

WAX PASTEL 

Caran d’Ache Classic 

Neocolor II water-soluble 

pastels in assorted hues
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4
Painting with watercolour and dry mediums
Once the panel is dry I can apply watercolours to create the base colours for 

the figure. I use an airbrush for this process. The trick is to get the values right and  
to make the base colours as soft as possible. Once the watercolour dries, I start to 
add details with coloured pencils. I start very light and soft, gradually building up 
more wax from the pencil by pushing harder into the paper. I’ll spend about 10 
hours rendering the figure with traditional mediums including coloured pencil, 
water-soluble wax pastels and more airbrushed watercolour.

3
Printing and pasting my line art to the board
I start printing my line drawing on to watercolour paper, using paper rather than canvas, because I use mostly dry mediums to create the 

character’s skin. However, I’ll be starting with watercolour, so I need to adhere the paper to the wooden board so that the paper doesn’t fold or 
wrinkle when it’s wet. To do this, I use a gel medium as the binding agent. The idea is to create a panel with a smooth paper surface (with my 
drawing already on it). Once the paper is glued to the panel, I wait for about a day to let it fully dry.

5
Generate textures with acrylic 
I’m going to bring texture into my digital image, 

particularly in the abstract shapes. I pick three acrylic 
colours: a pale yellow, a grey blue and a desaturated red.  
I now go crazy with paint, splattering and mixing almost 
indiscriminately. The messier the better! Note, however, 
that I’m trying to keep the colours and marks articulate 
and clear, because I know I’ll be selecting the colours 
individually in Photoshop to create more textures. 
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6
Photographing traditional work
Let me first say, this is the hardest part of the 

process. It’s very important for me to get a perfect 
representation of my traditional work at this point.  
I can manipulate it later, but for now I need it to be  
spot on. The panel I’m working on is large: 48x60 inches 
(121.92x152.4cm). It’s crucial to obtain a very large  
and clear image of this work. To do so, I use a digital SLR 
camera to photograph the work in sections. I take about 
30 pictures of the painting, starting from the top right  
and then working my way down to the bottom left. 

8
Adjusting a traditional 
painting in Photoshop

I now have a true-to-life (scale) image of  
my painting in Photoshop. However, the file’s 
shape and colours are out of whack. I open  
a new file that’s the same dimensions as  
my traditional painting at 200dpi. I select  
my painting layer, then click Edit>Transform> 
Scale, and adjust the painting to fit accurately 
in the panel. I need to make some further 

adjustments so I click Edit>Transform>Wrap, 
and finish adjusting the file. I now need to 
make sure the painting is exactly the same 
dimensions as my original sketch. I open  
the line drawing file I used to print the initial 
sketch and drag it on top of the painting file.  
I now scale my painting to match the drawing 
using the same Transform functions. Once the 
painting file is matched up with the line layer, 
I delete the line layer. 

The last thing I need to do is cut the figure 
out of the painting, turning the figure into a 
separate layer. There are many ways to do this. 
I like to punish myself, so I use the Polygonal 
Lasso Tool. Once the figure is selected I 
feather the edges to give a more natural look 
(Select>Modify>Feather). Now that the 
figure’s cut out, I can adjust the background 
layer and make the figure stand out even 
more. I use the Stamp tool for this step.

7
Photomerging my painting sections 
Now that I have my painting in sections saved to my computer, I use the 

Photomerge function in Photoshop. This function is the best! To merge your tiled 
photographs together click File>Automate>Photomerge. Click the Browse button, 
select the files you want to be put together and click OK. This can take some time 
depending on how many files you have, and if there are too many files the program 
will get bogged down and freeze up... I think you can only do about 30-ish files  
at a time. Some of my paintings need over 100 tiled files. I have to do them in 
sections. This takes some time and can get complicated, but practice makes perfect.
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10
Texture and gradients
I’m pretty obsessed with the primary 

colour combination red, blue and yellow. 
Luckily for me there’s a cheat (preset) in 
Photoshop that will make a gradient with 
these colours. I double-click the layer I want 
to add the gradient to, click the box next  
to Gradient Overlay, then click the words 
Gradient Overlay and the Gradient Overlay 
functions will pop up to the right. Click the 

Gradient Editor and select the red-blue-yellow 
preset. Easy as pie, don’t you think?

Now that I have my gradients done, I want 
to add some texture to the shapes to give 
them a traditionally painted look. I drag each 
shape layer to the file containing my original 
painting and use the (painted acrylic) 
background to add texture to the shape. I  
do this by selecting the shape layer with the 
Magic Wand tool to cut that exact shape out 

of the painted acrylic background layer 
(Edit>Cut, and then Edit>Paste) I drag the 
newly cut textured shape to the illustration 
file, then match up the textured shape with 
the gradient shape. I select the textured layer 
and explore the Blending mode preset 
options. I like using either Multiply, Color 
Burn or Screen, but I often just go through the 
entire set of options just to see what they look 
like. I do this to nearly every abstract shape. 

9
Tracing shapes from my sketch
I’m now ready to start my illustration. I open a new file and drag the figure 

and background to this new file. The dimensions are a little off and I have to fill up 
the top of the composition with more of my painted background. I do this by using 
the Transform and Stamp tools again. I’m now ready to start creating my abstract 
shapes. I open my sketch file and drag it to the newly formed illustration file. With 
the Ellipse tool I generate large ovals and Free Transform the shapes to match the 
shapes in the sketch, again using the Wrap function by clicking File>Transform> 
Wrap. I keep every shape separate on individual layers.
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12
Introduce more textures and noise
The illustration is coming along nicely now. It needs a little punch of texture, 

though. I want to make this feel like one of my traditional paintings. What better 

way to do this than to use one of my actual paintings? I select a painting that I made 

recently, use the Magic Wand tool to separate a particular texture and save it to a 

new file. I now drag the textured file on top of my illustration and Transform>Wrap 

the layer to fit the shapes in the illustration. I do this again, now to the figure, using 

the soft Eraser tool and by adjusting the Opacity of the textured layer over the body.

14
Apply the final touches
I zoom into the image and look for little adjustments that need to be made.  

I make sure all my texture and shape layers line up, and get rid of any unwanted 

digital noise. I also tweak the background with large colour blurs that are barely 

noticeable, but help move the colour around the artwork. I use the Gaussian Blur 

function for this. And there we have it – a traditional/digital illustration! 

11
Develop figure gradients
I want the figure to look like she’s wearing a 

gradient suit, almost as if it’s painted on her. I want to 

stick with the red-yellow-blue colour scheme so I use the 

same gradient preset. I differentiate the arms from the 

body by putting the arms on another layer and adjusting 

the gradient subtly. I feather both gradients into her neck 

and head with the Soft Erase tool. The figure still needs 

some work, but I want to finish the background first. 

13
Enhancing the face and hair
I use the Magic Wand tool to select the perimeter 

around her hair. I then feather the selection and erase 

from the hair, eliminating that harsh “cutout look”. I then 

create a new layer behind the figure and use the Soft 

Brush tool to paint wispy strands of hair. Then I use the 

Elliptical Marquee tool to create a white circle. I deselect 

the circle, click Filter>Blur>Gaussian Blur and adjust the 

blur to where it feels natural, giving the hair a soft glow. 

Now I select her face with the Lasso tool and put it on  

a new layer, then adjust the Levels and the Hue/Saturation.  

I then use the Burn and Dodge tools to give her face a little 

more value and colour. I do the same to her arms.
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In this workshop, Rafael Sarmento pays tribute to one  

of the most inspiring surreal artists of the 20th century

When I was invited  
to do this workshop,  
I immediately knew  
it wouldn’t be an easy 
task. Revisiting the 

work of a surrealist artist was both  
a daunting and exciting quest!  
I was asked to choose the artist, and 
Zdzisław Beksinski was the obvious 
choice for me. His atmospheric, often 
sinister baroque paintings are like 

windows on landscapes of relentless 
characters, striving to survive within 
forgotten worlds. 

My chosen painting is AE85,  
a spectacular and emotional piece 
that has an enigmatic character at  
its core, whose body is involved in 
(perhaps) the very fabric of time.

Since I’m obviously not a genius 
like Beksinski was, I decide to 
approach the task as an ode to that 

visionary mind, especially 
considering we’re talking about 
reinterpreting a masterpiece of  
fine art (which is embedded with 
meaning and content that are totally 
subjective). I need to be as objective 
as possible, even if I’m filtering  
the original art through my own 
sensibilities, in order to pay  
homage to the late surreal master  
in a illustrative, graphic and fun way. 

1 Finding the frame
I always begin a painting by doing small thumbnails (usually four) based on 

my initial research. Keeping the original painting as the base, I explore different 
combinations of compositions, poses and mood.

2 Reshaping the masterpiece
After deciding on a preferred composition, I enlarge 

the loose sketch to the size of the canvas, and start finding 
the shapes and lines. This early stage is pretty intuitive, 
mostly guided by the mood I’m searching for rather than 
trying to refine specific forms.

GET YOUR 
RESOURCES

See page 8 now!

Rafael 
Sarmento
LOCATION: Brazil

Raf is an illustrator and 

coffee aficionado from 

southern Brazil. Clients 

includes Wizards of the 

Coast, Riot Games and 

many others. 

https://ifxm.ag/rafael-s

Artist

 PROFILE 

´
´

68 June 2018

Workshops



69June 2018

In depth Revisit Beksinski´



4
Folding and unfolding
Now this is the beginning of the tricky part – 

making the folds work as the vessel for her body, 
conceptually speaking. Whether the fabric is unveiling  
or hiding her, a big part of the composition’s weight will 
centre around the main figure.

6
Applying texture
One of the key elements I usually work in my 

illustrations is texture. For this piece I’m using a mix of 
custom brushes created by True Grit Texture Supply  
(www.truegrittexturesupply.com) and some old paint 
textures that I rustled up myself ages ago.

3
Playing with geometry
One of the most striking things about Beksinski’s 

artwork is how he uses the fabric seamlessly to involve the 
character, giving it a dream-like quality. I aim to take a 
similar approach, using geometric shapes as unfolding 
parts of the cloth. I want to leave it up to the viewer to 
decide if it’s the figure’s clothing or part of her body.

5
Portraying the figure
I’m working intuitively during this stage, and need 

to ensure that any decisions I make now won’t be hard to 
modify at a later stage, as I adjust/update the composition. 
At this stage I’m certain she’ll have a stylised appearance, 
to keep to the premise of making this artwork look and 
feel surreal, while tangible at the same time.

PROCREATE

SPLITTER BRUSH

To add a bit of grain to 

the character’s skin,  

I take the Spatter (also  

a standard brush in 

Procreate) and then work 

it on a low Opacity layer, 

with the brush mode set 

to Overlay 

I use an altered version 

of Procreate’s default  

6B Pencil in Procreate  

for most of the 

illustration. I only need to 

change its size to take it 

from a drawing pencil to 

a thick painting brush.

CUSTOM BRUSHES: 

THE FREAKING BRUSH

Keep things 
lean and mean
Maintaining a 

streamlined workflow 

with only Procreate as 

my main tool and a few 

other apps for colour 

tweaks) drastically 

improved my painting 

process. It took me out 

of my comfort zone and 

forced me to paint more, 

and better. Having to rely 

on fewer art gimmicks 

ended up boosting  

my skills.

´
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8
Colouring the shapes within the piece
One of Procreate’s great features is the Color Drop tool. You “grab” the colour you’re using with the Pencil and drag it over the part you  

want to colour (there’s a threshold control after you drop it). I start using this to colour different parts of the fabric’s shapes as I seek to achieve a 
balance of contrasting colours while creating the tension that will help drive the viewer (along with the shapes and lines) through the piece.

7
Adjusting my values and colours
Procreate is, in my mind, the best-designed program 

for drawing and painting. Unfortunately, it lacks certain 
colour settings and adjustment tools, so I move the image 
back and forth between some apps to adjust the colours 
and mood. Apps such as Snapseed and VSCO provide 
more than enough control over the atmosphere that I’m 
trying to achieve in the painting, and are ridiculously  
fast to use, too!
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10
Having fun with layers
A fundamental part of how I create the overall 

mood and colours of a piece has a lot to do with 
experimentation, especially using layer properties.  
An example of what I do is creating a flat colour layer  
on top of everything, set it to Exclusion and then  
reducing the Opacity to around 50 or 60 per cent.

9
Keeping things organised
Since I’m essentially creating visual chaos with elements that I can play with 

during the painting process, I try to at least keep things (slightly) organised. I place 
some of the texture layers apart from each other, as well as some elements of the 
painting that, at this point, I’m not sure how I’m going to finally place.

Double the fun
One of the iPad Pro’s 

coolest features is the 

Dual Screen, which 

enables you to keep your 

browser or references 

open on one side of the 

screen, and Procreate at 

the other! Since I’m using 

the 12.9-inch model,  

it can perfectly 

accommodate 

everything at a 

comfortable size, 

whenever I need it.

11
Selectively mixing and matching
Now that I’ve got my Exclusion layer established, I open the Cut/Copy/Paste menu, press Copy All and then 

Paste. This creates a flattened image with the altered colours, which I set to Lighten or Darken. Then I move, cut and 
paste elements from this flat layer, and add them to my work-in-progress artwork.
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Get in, quick! 
Procreate has, among its 

many other features,  

a very effective Quick 

Menu that activated with 

a simple touch on the 

screen. You can 

customise it to contain 

whatever items you 

want, and this makes it  

a real time-saver that’s 

sure to boost your 

productivity levels.

12
Designing the symbols
Graphical elements enable me to balance and contextualise the narrative within an illustration. I can juxtapose 

the organic forms and lines, creating a layer of abstraction that I think acts as a fun bridge between the atmospheric, 
dark worlds of Beksinski and the contemporary approach that I’m taking.

13
Fine-tuning the art
Now that we’re nearly at the end of our journey, it’s 

time to double-check everything and make sure the 
elements in the composition complement each other. This 
is where I make use of the layers I kept separate earlier 
(such as some textures or design elements) to be sure 
they’re working together, before flattening everything so  
I don’t end up with a large, unwieldy image file.

14
And it’s a wrap!
Here we are! Before calling it a day, I make sure to keep some earlier steps for 

comparison, export the Time Lapse process video (one of the coolest features of 
Procreate), and we’re done. Hope you’ve enjoyed this workshop. I can’t match the 
mastery of Beksinski, but I hope I can honour him at least just a little bit. See ya! 

´

´
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PAINT A CORPSE 
THAT’S FULL OF LIFE
Peter Polach attempts to elevate the mood of a traditionally grim topic 

by focusing on joyful expressions and using bright, lively colours

I’ve always liked the 
undead, and will often 
root for the ragged 
underdog who’s so 
often reduced to a 

moving target (“Headshot!”). Many 
of my works feature characters who 
have a ghoulish appearance, and here 
I’ve used an unnatural cold skin tone,  
with gangrenous fingers to depict 
that age-old trope of outstretched 
zombie arms. However, I’ve decided 

to look at the bright side of death and 
painted them as colourful, friendly, 
magical people, expressing glee and 
enjoying their new lifestyle choice. 

Colour is a dominant aspect in 
many of my works, and I like to 
experiment with it. Of course, one 
needs to understand the basics of 
colour theory before attempting  
to explore it further. I think that a 
combination of what should happen 
according to the laws of physics, the 

artist’s expectations, the glitches in 
one’s vision, and the fuzziness of the 
brain’s interpretation of what  
it thinks it sees, is the best way  
to express colour in a painting. 

The ‘deep dream’ images created 
by an AI program have opalescent 
overlay that appeals to me, and so  
I’ve tried to clumsily implement this 
effect into my art. I’ve realised that 
using a colour which has no business 
being used can be a lot of fun.

Artist insight

Peter Polach 
LOCATION: Slovakia

Peter, also known as 

Apterus, is a freelance 

illustrator and concept 

artist who enjoys 

depicting creepy things 

and bright colours.

https://ifxm.ag/apterus

Artist
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How I create…

A COLOURFUL ZOMBIE

3  Carrying out multiple 
rendering adjustments

My lack of planning means I have to make 

tweaks to many elements in the scene. 

Since I discovered programs like Corel 

Painter and Paintstorm Studio, I use them 

for brushwork, because their brush engines 

are more intuitive and better suited to my 

style of painting. Photoshop remains my 

first choice for large-scale adjustments.

2  Firming up the elements 
and telling a story

Now I’ve got a good grasp of my 

composition, and have come up with some 

ideas on what should be added to make it 

work. I further define the scene, choose my 

colours and add secondary elements. In this 

case it’s a collection of arms that support 

the main figure, while also adding more 

movement and a hint of a story.

1  Dealing with the 
consequences later

I readily admit that it’s incredibly inefficient 

to start with only a vague vision of the main 

character. I have no idea what I want the 

picture to look like, but I tend to produce 

better results when I just skip most of the 

planning and get straight to it, leaving many 

aspects to fate. This approach happens  

to work for me, but I advise against it!

GET YOUR 
RESOURCES

See page 8 now!
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ESSENTIAL ART  
RESOURCES

Exclusive videos and 
custom brushes are 
available with your  

digital editions!

Just search for ‘ImagineFX’ on these selected platforms…

Get a digital subscription to 
ImagineFX and save money!



A LIVELY DEATH SCENE

UV colour scheme
I start with conservative purple-grey 

tones and gradually mix them with 

random hues until a stronger palette 

begins to emerge. When I’m satisfied 

with what I see, I push the palette 

towards the toxic-looking, unnatural 

tones that can be seen under a  

UV light using soft colour overlays.

Bring in more light 
Late on in the process I add a new, 

bright light source to introduce more 

drama and draw attention to the 

character’s face. I use a masked Curves 

adjustment layer and a soft brush  

in Photoshop to preserve the details  

of my almost-finished painting.

Visual padding 
I often use swirling rich drapery 

for areas that have otherwise 

very little to offer, to balance 

the overall composition. My  

aim is to create a scene that’s 

staged and tightly packed.

Making sure everything’s in order
Human anatomy, especially hands and faces, are so familiar to  

us that even without any formal knowledge we can easily spot 

mistakes. Therefore, reference is extremely important for  

my work. I try to include something previously unexplored into  

each new illustration, to avoid getting stuck in a rut. I’ll study the 

subject matter and immediately put my knowledge into practice.

Final touches
I always aim for a painterly look 

in my work, so towards the end 

of my process I import a photo 

texture of a painted surface, set 

it to Overlay mode and adjust  

it to match the shapes and main 

strokes of my painting with a 

strong smudge brush. I use the 

High Pass filter and a little bit  

of chromatic aberration to 

make the painterly structure 

pop even more.

RESOURCES

PHOTOSHOP

This is the brush I use  

for almost everything, 

regardless of the 

software. It’s a rectangle 

with natural edges and 

with a faint texture.  

I usually set my brushes 

to simulate soft chalk  

as much as the program 

makes it possible.

CUSTOM BRUSH: 

SOFT CHALK
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Depth determines how 

dramatic the effect you’re 

applying is, and creates more  

or less light and shade. Size will 

determine how big the effect 

looks on the object, while then 

the Soften slider creates a 

rounded finish to the bevel.

You can access the bevel 

and emboss options by 

clicking Layer>Layer 

Style>Bevel & Emboss. You 

can also choose other layer 

styles from this window.

PHOTOSHOP: WORK 
WITH LAYER STYLES
Mark White takes a look at the world of Layer Styles in Photoshop, how 

they can improve your art and how you can arrange them effectively

Non-destructive 

editing is where you 

can make changes to 

images without having 

to make them 

permanently. Think masking on a 

layer mask rather than erasing parts 

of your layer forever, or even just 

duplicating your entire document  

to another folder while you do 

something a little risky to it. 

 Layer masks fit into this category, 

too. They’re quick fixes that you can 

apply to layers to make them stand 

out from the layers below them. Best 

of all, anything you apply to your 

layers – whether it’s a glow, a shadow 

or even a complete remodel of it via  

a bevel – doesn’t have to be forever. 

Layer styles can be stacked too, just 

like other layers, and by using the 

Fill, you can reduce their Opacity 

without changing the Opacity of the 

layer that they’re applied to.

 Remember, when you’re finished, 

if you wish, you can use the Rasterize 

Layer Style option to set it 

permanently – destructively, if you 

like. Let’s dive into how you use layer 

styles on a simple digital illustration 

of an apple, which is made up of a 

number of layers of selections, 

created with the Pen tool.

1 Make the most of the bevel and emboss options
Bevel and Emboss are shaping tools for giving your objects subtle contour and volume. They apply natural-looking highlight and shade to 

your selections, and you can even go as far as to pick a specific style and smoothness of the effect.

Core skills: Part 3

Mark White
LOCATION: England

Mark is the techniques 

editor at Photoshop 

Creative magazine. He 

uses Photoshop almost 

exclusively, and has been 

using the software for 

over a decade. 

be.net/mrkjhnwht

Artist
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Highlight and Shadow Mode are two sliders for 

completely controlling the light and shade, from 

how severe it is to how it hits the object. Use 

Overlay for both for subtlety, and use Screen 

and Multiply respectively for a more severe 

effect, for example.

The Angle option will help  

you to align the light from a 

specific direction, and Global 

Light will enable you to have 

all objects with layer styles 

following the same light 

direction. Use the Contour 

feature to alter the texture  

of the bevel itself.



Blend mode and Color are what 
determine how your drop shadow reacts 
with the layers below. Choosing a dark 
colour and Multiply will create a shadow 
effect, while a light colour and Screen 
will introduce more of a glow effect.

Distance can help position 
your shadow a little further 
away, and the Spread slider 
can control the density of  
your shadow. The size will 
determine how big it appears; 
reduce it right down to have a 
completely hard edge.

Just like with the Bevel & Emboss section, Contour can  
help you to change the actual texture of the shadow, when 
combined with Noise. This isn’t commonly used, but is still 
worth experimenting with nevertheless.

Choose a colour, pattern or  
a gradient that you wish to 
apply as an overlay by clicking 
the colour icon. Then apply 
either a preset gradient, or 
choose your own with the 
colour picker.

This should be used for 
selections of colour, in a 
similar way to how you 
might clip a layer to 
another layer as a clipping 
mask. Overlays are 
capable of altering the 
Opacity or Blend mode  
to react in different ways.

You can alter the 
direction that you  
wish for the gradient  
or pattern to follow,  
by using this icon.

2
Multiple ways of working with overlays
There are so many ways to fill a selection with colour, but Gradient, Pattern and Color Overlay in Layer styles are three of the most reliable. 

These colours will fill the object whether you move it or not, and you can even change the Overlay’s Opacity and Blend mode.

3
Apply a drop shadow to your art
The Drop Shadow is one of the most versatile Layer Styles that you’ll find in Photoshop. It’s not only used for the obvious, fuzzy black space 

behind objects, but it can be used for an almost unnoticeable way to make an object stand out in a painting.

Copy and 
paste styles
Ctrl/right-click a layer in 

the layer palette and 

select Copy Layer Style 

to copy. Go to another 

layer and do the same  

to paste it.

Core skills Photoshop
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5
Emphasise an object’s appearance with a Stroke
Perhaps the simplest layer style of all, the Stroke option is just a basic outline around the inside, outside or centre of your object. Change the 

colour and blend mode, and use it to make some selections stand out a lot more than others. 

4
Alter the intensity of light with the Glow layer styles
The Inner and Outer Glow layer styles are two of the most popular available for controlling light or shine. They’re mostly used just with a 

bright white colour, but this doesn’t mean you can’t apply them to other colours.

Opacity and Noise 

can help to define 

exactly how bright 

and clear the glow 

itself looks. Change 

the Blend mode too 

to alter the way the 

glow looks against 

the colours behind it.

Pick a colour and gradient with the options 

available. Using a gradient can be useful  

if you only want the glow to appear over 

some of the object.

The Elements box will help you to set a Choke and 

Size. This controls the intensity of the glow to a 

degree; the smaller these numbers are, often the 

more realistic it looks.

Workshops
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The Size slider is the 

most important when it 

comes to Stroke. Use it 

to determine whether 

you want a thick, 

obvious line around your 

selection, or a hairline 

stroke to just subtly 

highlight a selection.

If you choose the Inside option for the Position, 

the stroke will likely have sharper edges; if you 

choose Outside, the stroke will curl around 

pointy edges in your selection. Centre is the 

midpoint of these two styles.

The Color and Fill Type options are  

there to choose the important details. 

Again, use a gradient if you only want a 

partial stroke around your object.
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P lus!
Portray better 
portraits 
Improve your figure 
art skills with Mel 
Milton’s pro advice.

20,000 DVDs 
and counting 
Giuseppe Cristiano’s 
art studio is a film 
buff’s treasure trove.

Gandalf vs the 
Balrog… fight! 
Nicolas Delort depicts 
an iconic scene from 
The Lord of the Rings.

ISSUE 162 ON SALE IN THE UK Friday 18 May

See how Ara 
Kermanikian 

builds this scene 

in 3D, ready  
for painting

Next month

Explore a new 
dimension!

Master VR, ZBrush paint-overs and sculpting,  

and get the skills you need to combine  

2D and 3D in your creative process



STREAMLINE YOUR 
COSTUME DESIGNS
Paul Gerrard treads the fine line that exists between loose, conceptual 

illustration pieces and workable, tangible costume designs

Designing for 

costumes requires  

a lot of research and 

many questions to be 

answered before you 

even begin your painting process. 

Skimp on this stage and your 

clothing ideas become little more 

than eye-catching concepts.

I was recently asked to work on 

Hellboy: Rise of the Blood Queen.  

I presumed that it would be creatures, 

antagonists and mutants, as is 

normally the case in my dark corner 

of conceptual art. To my surprise, the 

commission was for pure costume 

design. I love a challenge, so I 

embraced it, but I had to adapt 

quickly. Costumes have always 

played an important role when 

concepting characters; they add to the 

visual tone. Costume design is a 

different discipline, but all characters 

need clothes, so how hard could it be? 

Turns out it requires far more 

precision and a hell of a lot of 

research! Here, I’ll share with you my 

findings, work process and tips that 

will help the development of your 

characters’ costumes. I’ll be focusing 

on two costumes created for one 

character: a standard costume and  

a battle armour version. Let’s suit up.

1
Outline your character’s story
Who is your character? In my piece she’s the captain of the royal guard in  

a fantasy world. A young princess, a warrior, a rebel. For her costumes I want to first 

present a formal/military outfit with the basic armour tech on show, and for the 

second, a battle-ready armoured uniform. I want them to work in unison and the 

armour to be a key feature in both designs. She has to be edgy and have attitude.  

I collect references of faces and costumes, and create a series of mood boards.

2
Reflect the world she lives in
This is a large part of the research phase. You have 

to understand the world that your character inhabits. In 

this instance I’m going for a futuristic world with a slight 

Renaissance vibe, so of course I’ll need to show this in the 

design. I look through some of my older pieces to help me 

develop a starting point. I’m not looking to get down pose 

or detailing ideas – just the general tone of the piece.

Photoshop

Paul Gerrard
LOCATION: England

Paul started out creating 

aliens for Battle: Los 

Angeles, and quickly got 

hooked on developing 

characters for films and 

TV. He’s known for his 

dark and disturbing art. 

www.gerrardart.com

Artist
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4
A question of pose
You’ll need to pose your character so that the costume’s clearly shown, but 

don’t make the stance dynamic. The goal is to present the detailing of the costume, 
not create a character illustration. I often choose a simple fashion model pose. Look 
at fashion magazines and collect online gallery stills of fashion models in action.  
There are plenty of fashion croquis (quick sketch) templates available online, too.

3
Consider tone and presentation
Decide on the right tone and maintain it throughout the design. A good way 

to do this is in the presentation style. I’m going for a semi-retro look: a pale beige 
background with a border. It helps to sell the tone from the outset, while ensuring 
your costume design is front and centre. I’d refrain from using any imagery in the 
background, although an exception would be a close-up of the character’s head, 
such as in this earlier piece of mine: Evil Lyn from Masters of the Universe.
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6
Be inspired by your materials
As a concept designer, you don’t really think too much about materials, fabrics 

or indeed how an actor would wear an outfit. But as a costume designer often your 

ideas come from a particular type of material, so keep that in mind when you’re 

sketching. Create mood boards and place images of materials next to your design 

elements. Then explore different variations, colours and textures.

5
Everything starts with a sketch
I concentrate on lines that represent folds in any 

fabric, and create interesting shapes and patterns. For 

example, the V-shape in her armour is repeated in her 

dress and overcoat. I keep these initial sketches simple, 

and focus on flowing lines and blocks of colour.

7
Don’t overlight the design
On a standard character illustration I’d place a third 

of the figure in shadow to add more depth. I’d also add 

elements of dynamic lighting, and blur parts of the scene 

to enhance the mood. However, for costume design art 

you should forgo the shadows and keep the lighting to  

a minimum, to clearly show off the outfit. This might go 

against your instincts as an artist – the figure might look 

flat, like an unfinished painting – but resist the urge to 

properly render the scene. If you do, you’ll only dilute  

the message that the design is trying to communicate.

8
Keep things clear and defined
Don’t overwork the image. Maintain clear lines, defined details and 

recognisable textures. I keep my lines on a separate layer so I can quickly refer to 

them. A good design is not only recognisable, but easily recreated, too. Think about 

structure in relation to the material. For example, the armour’s made from a bronze 

and steel material, so my lines are sharp and heavy to emphasise how tough it is.
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11
Think ahead
Keep each piece of clothing on a separate layer.  

I create my imagery in black and white and then add  

a layer of colour followed by the texture or details.  

This enables me to change elements at any time. There’s 

nothing worse than finalising your image, only for the 

client to request a quick colour change. Or even worse, ask  

to swap out the materials of a particular piece of clothing.

10
Introduce motifs
Repeating motifs and identifiable fashion elements 

help to maintain a sense of consistency between the 

character’s two outfits. For example, the triangle theme 

that’s evident in the coat and dress now appears on the 

body armour. The snake motif, while subtle, appears on 

the helmet and the sword if you look carefully enough, as 

well as within the central body armour section.

9
Creating the battle armour version
This is where it gets tricky, when you put on your practical hat and start asking 

more questions. Is the armour placed on or strapped on? How does it work? If it’s 

high-end tech then perhaps it can be multi-layered and unfold from a central 

device. Furthermore, what’s the theme of the armour? Here, I’m going for a subtle 

snake theme mixed with a retro 1920s vibe. I want it to look like it grows, so I create 

two versions: one before and one after it’s activated. Again, take into consideration 

how this might look in real life. Something too big and bulky will look unrealistic.
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13
Give your character suitable accessories
This is often an afterthought of costume designers. Designing accessories  

such as weapons – guns and swords, for example – is my favourite part of the 

process. I take the time to hone the design of these accessories so that they have  

a character all of their own. One approach is to imagine them as a toy line.  

What would make them stand out on the shelf? What would make you buy it?  

Note that the gun follows the same V-shape design elements as the costume itself.

12
Illustrate more than you can see
The final design with all its layers will often hide 

elements of the clothing that a client may want to see 

later. Pre-empt this by illustrating everything in layers  

and completing each layer of clothing. Think of the 

process like dressing a doll: start at the beginning and  

up build the layers. This will also help illustrate how  

one piece of clothing may hang or interact with another.

14
Prepare the modesty layer
Using Photoshop is extremely handy at times.  

You can anticipate most client changes ahead of time  

by simply working in extra layers. I always create modesty 

layers: one image to sell the sexy nature of the character 

and another more realistic ‘costume’ layer that covers  

up any exposed areas of skin deemed to be too racy.

15
Bear in mind self-promotion opportunities 
Once the design is signed off I often do a ‘magazine’ edition. This is a glossy 

showcase version that’s for my own collection, and are perfect for promo work. 

Remember that your costume design images are often only ever seen in-house. 
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HARDWARE

90 Cintiq Pro  
An already strong product category is about 
to get stronger as Wacom adds two new 
Cintiqs and a new PC option.  

TRAINING

93 2018 Lesson 01:  
Ursus Warbear 
Concept artist Dongjun Lu shows how to 
create games characters from scratch in this 
monster-sized Gumroad video.  

BOOKS

94 The Big Bad World Of 
Concept Art For Video Games 
Concept art is a cut-throat career choice. 
Luckily, one industry pro guides you on 
your way with his hard-earned advice.

95 Okja: The art and  
making of the film  
Unleash your inner animal activist with 
this behind-the-scenes book dedicated to 
the realisation of a giant man-made pig.

95 Beginner’s Guide to ZBrush 
Take your first steps into the world of 3D 
sculpting with this thorough and accessible 
guide that’s aimed at newcomers.
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the test by the ImagineFX team…
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Artist’s Choice award!



Price £1,900 (24-inch, pen only); £2,400 (24-inch, pen and touch); 32-inch £TBC  Company Wacom  Web www.wacom.com

Cintiq Pro
DOUBLE THE FUN An already strong product category is about to 

get stronger as Wacom adds two new Cintiqs and a new PC option

he latest additions to 

Wacom’s product line are 

two new Cintiq Pro 

displays. The 24-inch (Pen 

only and Pen and touch versions) will 

be released imminently, and the 32-

inch follows later in the year. 

With that we see the announcement 

of the new Cintiq Pro Engine. This is a 

PC that slots into the back of the new 

Cintiq models, and turns them into 

standalone computers. These modules 

go on sale in May (prices TBC). Both 

models of the Pro Engine performed 

well with all our tests. Even the lower-

T
The Pro Pen 2 comes 

with a wide range of  

nib types, which are 

found in the very solid 

Pen holder.

USB3 and an SD card 

reader on the side of 

the panel help with 

peripherals and adding 

your own files.

There are two new 4K Cintiqs 

in the range: the 24-inch, 

available now, and a 32-inch 

to follow later this year. The 

ExpressKey Remote is a 

standard feature on the 

newer models.

spec version that features an Intel i5 

CPU turned out to be no slouch.  

If you’re using it for 2D applications,  

you aren’t going to push it to its limits.

Both new Pen displays have a 

whopping 4K screen resolution 

(otherwise known as Ultra HD, 

3,840x2,160) and 99 per cent Adobe 

RGB – and they are stunning. You’ll 

soon notice that each device features 

bright, punchy displays with an etched 

glass finish. This improves the glare 

issues from earlier models and gives  

a slight ‘bite’ to the surface that’s more 

akin to drawing on paper. 

Wacom has reduced the parallaxing 

effect that some complained about in 

previous models, through what it calls 

‘optical bonding’ – and it really does 

work. The pen nib feels tight on the 

screen and during all of our tests on 

both models we experienced zero 
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latency in any of the 2D and 3D 

programs that we used them with. 

There’s support for the Pro Pen 2 

and that means there’s now 8,192 

levels of pressure sensitivity. It’s 

difficult to know if that improved the 

pen experience, because previously 

we thought that performance was 

pretty amazing at 2,048 levels! If 

you’re willing to spend an extra £90 

you can upgrade the included Wacom 

Pen to the newer 3D Pen that comes 

with three buttons.   

One feature that we loved on the 

new screens is that Wacom has added 

an AV switcher to the onscreen 

controls. That means that even if you 

have a hefty workstation attached to it 

in your studio, you can plug in your 

MacBook, say, and hot-swap between 

the two computers with a screen 

press. It’s a tiny addition that will make 

a real difference to people’s workflow.

Artists using 2D painting software or 

3D programs such as ZBrush will love 

the high resolutions and huge screen 

real estate that you get with these 4K 

screens. The 32-inch model used 

standing up is pretty much like drawing 

on an A0 drawing board. Try the 32-

inch before you consider buying it 

because it’s a huge physical presence 

in your office or studio. Don’t even 

consider it if it’s for your bedroom! 

The Pro Engine simply slides in and 

docks to the connectors inside the  

back panel. It can also be used as a 

standalone PC with a standard monitor.

Both Cintiq models have 

pull-out legs on the rear 

of the panel. A new 

stand will be available as 

a separate purchase 

later in the year.

This side-on profile shows how 

steep the Cintiq is, even with  

a Pro Engine inside.

Features
4K Ultra HD display   

(3,840x2,160

522x294mm active 

area (24-inch model)

 1.07 billion colours 

(10-bit), 99 per cent 

Adobe RGB

USB C, DisplayPort 

or HDMI2.0 graphic 

input options

1,000: 1 contrast 

ratio; 350 cd/m2 

brightness

Four USB3 ports, 

one USB C port, one 

HDMI2.0 port, one 

DisplayPort.

Audio headset jack, 

built-in microphone 

Rating

 Both new Pen displays have a 4K 
screen resolution, otherwise known as 
Ultra HD – and they are stunning 

GLEN
SOUTHERN

With 4K, this artist has taken his   
first step into a larger world…

ARTIST INTERVIEW

What’s your favorite feature  

of the new Wacom product?

I was using the 27-inch model for 

several years and loved it, but the 

addition of the 4K resolution just 

improves things immensely. That 

amount of screen real estate is a 

game changer for me.

Why has that made such  

an impact on your work?

If you have bad eyes you’re going 

to want to tinker in your OS with 

the text and icon sizes: at 4K 

everything is impossibly small at 

first! As soon as you tweak the 

size to work for you, it’s amazing.

What software do you use 

with the Cintiq?

My main tool is ZBrush and the 

first thing I did was to configure 

the interface to suit a 4K panel. 

Now I can have more of my key 

tools pulled onto the interface, 

speeding my up workflow.

So have you moved away  

from multiple monitors?

I quite often used either a third of 

the screen from top to bottom or 

to the right side for reference 

material. I’m so used to having a 

Cintiq and an external monitor 

for reference so it’s nice to fit it all 

into one screen. I don’t think I 

need that extra screen at all now.

Has the newer specs of the 

panel made a difference?

The colours are vibrant and the 

new surface etching just gives a 

tiny bit of drag on the pen nib and 

feels very pencil-like. Using 

Mischief to concept ideas is 

liberating. Because it’s an 

unlimited canvas and you’re using 

it at 4K resolution, it gives you a 

wide open infinite canvas in all 

directions, including in and out. 

Glen runs SouthernGFX, a 
small studio specialising in 
character and creature design 
and look development.

www.southerngfx.co.uk

System 
Requirements
PC: Windows 7 or later

Mac: OS X 10.11 or later

Art tools Hardware
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HUGE EXCLUSIVES DEVELOPER ACCESS RETRO CLASSICSTHE BIGGEST NAMES

QUALITY. INNOVATION. RESPECT 
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INDUSTRY SECRETS

BUY YOUR ISSUE TODAY
Print edition available at http://bit.ly/gamestmshop

Digital editions available on iOS and Android

Available 
from all good 

newsagents and 
supermarkets

facebook.com/gamesTM twitter.com/gamesTMmag

Available on the following platforms

ON SALE NOW
THE FUTURE OF FORTNITE  NINTENDO LABO  INSIDE KNIGHTS AND BIKES



Publisher Dongjun Lu  Price £11  Format Download  Web www.gumroad.com/ludongjun

ARTIST PROFILE

DONGJUN LU

Dongjun Lu is a senior concept 

artist specialising in film and 

games projects. He was based in 

Singapore, but recently moved to 

Wellington, New Zealand to join 

Weta as a concept artist. Dongjun 

has worked on franchises such as 

Dragoborne, Toukiden, Ninja 

Gaiden, Nobunaga’s Ambition, 

Romance of the Three Kingdoms 

and Uncharted Waters. He’s also 

been teaching digital drawing  

for six years now, 

and releases an 

online lesson every 

month through his 

Patreon page.

www.ludongjun.com

notes about the character and its 

environment, creates initial sketches to 

try ideas out, then works one concept 

up into a more finished piece.

The two videos here, clocking in at 

over nine hours altogether, show the 

making of a bear-like creature in an icy 

setting and a hunter in a jungle. You 

also get the full Photoshop documents 

of the concept pieces, and a selection 

of custom brushes Dongjun used.

The videos are in real time rather 

than being sped up, which means that 

some sections feature repetitive 

detailing, and Dongjun sensibly 

chooses to restrict his audio 

commentary to key moments rather 

than attempt to occupy hours of 

airtime. While this gives patient 

viewers the benefit of seeing the 

artist’s entire process, perhaps some 

editing down or use of time-lapse 

would help to focus attention on the 

important steps of IP creation. 

BEAR NECESSITIES Concept artist and teacher Dongjun Lu shows how to create 
video game characters from scratch, in this monster-sized Gumroad video

elcome to the new era of 

online training, where 

artists and illustrators can 

teach their fans new skills. 

At the same time, fans have the 

chance to support their inspirations 

through donations. It’s a virtuous 

circle that enables artists to invest 

more time in creating richer, more 

rewarding training material.

Dongjun Lu offers a package of 

video and associated files every 

month. You have the option of 

choosing individual downloads via the 

online marketplace Gumroad or 

subscribing to all of his releases via the 

artist supporter website Patreon. 

Dongjun’s first release of the year 

sees him discussing the creation of 

characters (IP or intellectual property, 

to use the industry term) for an 

original game project he is working on 

with some friends. Across two videos, 

you’ll see how he starts with simple 

W

2018 Lesson 01: Ursus Warbear

The two videos in this 
package are over nine 

hours altogether; as 
well as the bear warrior, 

Dongjun crafts a 
jungle-dwelling hunter.

This imposing warrior is a character in a 
proposed game project. Dongjun Lu 
shows you how it was developed, from 
initial notes to finished concept. 

Dongjun shows how  
he adds colour over  
his preferred sketch,  
before bringing in the 
backdrop and piling  
on relevant details.

Topics covered 

IP creation

Using reference

Initial sketches

Introducing colour

Adding detail

Length
653 minutes

Rating

Inspiration Training
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Author Eliott J Lilly  Publisher Design Studio Press  Price £28  Web www.designstudiopress.com 

R

Eliott uses this example 

of a character concept 

to point out certain  

dos and don’ts.

Eliott’s worked on big 

game franchises such 

as Rage, Doom and 

Call of Duty.

Advice is given on how to submit mailers to art 

studios. Eliott sent this package to Activision.

but that won’t help you get a foot in 

the door if you don’t have the business 

nous to match.

Split into 10 chapters, this 120-page 

book rattles through the key 

challenges of promoting yourself, job 

hunting and dealing with setbacks in  

a refreshingly concise yet informative 

way. And while some sections are 

more thin on the ground than others 

(the opening chapter is a four-page 

wake-up call dedicated to the truth 

about concept art and employment 

opportunities), each one will help 

readers hone in on how to take their 

first steps in the growing industry.

This doesn’t mean that the book 

comes across as didactic when it’s 

time for choosing a career path. In fact, 

Eliott goes to great efforts to provide  

a balanced and realistic look at how 

concept artists can expect to progress 

should they, for example, become  

a generalist or a specialist, or decide  

to work with a first-party or 

independent developer.

Some of the insights, such as how to 

network or construct a cover letter, 

might seem like fairly standard career 

HELPING HAND Concept art is a cut-throat career choice. Luckily, one industry 

pro has put pen to paper, to guide you on your way with his hard-earned advice

arely do career advice 

books acknowledge the 

competitiveness of an 

industry in their title, but 

with over a decade of professional 

experience under his belt, Eliott Lilly 

knows when concept artists need  

to be told the truth upfront. In this 

second book in the series, which 

picks up where its predecessor An 

insider’s Guide for Students leaves 

off, the sought-after concept artist 

for video games shares the hard-won 

lessons he’s learnt over the years. 

Aimed at upcoming professionals 

and artists looking to move into the 

entertainment industry, this book 

focuses on the real-world career 

hurdles that concept artists will need 

to be prepared to deal with. As Eliott 

repeatedly points out, you might be 

the best concept artist on the planet, 

The Big Bad World Of Concept  
Art For Video Games

advice, but it’s rewarding to see how  

it applies to concept artists specifically. 

If anything, this book will streamline 

the process of putting together a job 

application, distributing mailers and 

negotiating a salary.

Given the nature of how concept  

art is often retained by the employer, 

there’s not much in the way of imagery 

to enjoy in these pages. But we’re here 

for the guidance rather than the art, 

and in this regard Eliott successfully 

delivers a punchy introduction to the 

working world that doesn’t shy away 

from the uncomfortable truth: you’re 

going to have to work damn hard.

RATING 

 This book will streamline 
the process of putting 
together a job application 
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Although Eliott’s art speciality is sci-fi, his 

advice can be applied to any concept genre.



Raul Tavares’ creation 

of his fantasy-themed 

character is described 

across 54 pages.

Storyboard from the 

climax of the film –  

a chase scene that 

takes place in a 

shopping mall.

Okja gets a bit of a wash 

behind the ears from 

Mija, the lead human 

character in the film.

Downloadable 

resources such as 

videos and .ZBR files 

accompany the 

workshops in the book.

P

A

oignant storytelling can 

spring from surprising 

places. In the case of Okja, 

a film whose titular 

character is a super pig, even a 

sizeable creature’s ‘epic pooping’ 

can set up a plot development.  

As director Bong Joon Ho puts it, 

“watching the scene where she’s 

pooping, you feel the magic.”

This bizarre revelation is indicative 

of the sort of creative decision-making 

s freelance ZBrush sculptor 

Maarten Verhoeven 

reveals in his introduction, 

once you start playing 

around with ZBrush you’ll see that it’s 

easy to work with and is designed to 

benefit users with existing art skills.

This is because ZBrush, instead  

of focusing on the technical side of 

creating 3D art, takes more of an 

accessible, spontaneous approach. 

And in this guide you’ll find a similar 

Okja: The art and making of the film

Beginner’s Guide to ZBrush

PRIME CUTS Unleash your inner animal activist with this behind-the-scenes  

book dedicated to the design and realisation of a giant man-made pig

NEW DIMENSION Take your first steps into the world of 3D sculpting 

with this thorough and accessible guide that’s aimed at newcomers

you can expect to read about in this 

making of book. The film is a quirky 

beast that tackles big issues such as 

consumerism and self-worth, and has 

been described as possibly ‘the most 

vegetarian film ever’.

Opening with a chapter dedicated 

to the design of the film’s super pig, 

this book then takes us on a tour of the 

locations in the film and introduces us 

to the main (human) characters.

explanation of ZBrush’s tools, 

workflows and systems to help you  

hit the ground running.

Established 3D artists, including 

Ruben Alba, Raul Tavares and Carsten 

Stüben, present chapters that tackle 

specific specialities of the software, 

such as hard surfaces, detailed 

sculpting and meshes. Elsewhere, Glen 

Southern gives a great overview of the  

program’s interface and its key tools.

Besides Ojka, most of the images 

here are limited to brisk digital concept 

paintings and storyboard art. Useful 

for animators, directors, and concept 

artists, and as a reference for fans  

of the film, this book is an odd yet 

engaging creature depending on  

what you want to get out of it. Rather 

like Ojka herself.

RATING 

While it’s aimed at beginners, this 

guide doesn’t talk down to the reader. 

Key concepts are explained clearly, yet 

there’s an element of having to read 

closely in order to keep up. The lessons 

quickly build up and pay off though, 

making this a rewarding and insightful 

introduction for artists looking to add 

a new dimension to their work.

RATING 

Author Simon Ward  Publisher Titan Books  Price £30  Web www.titanbooks.com

Editor Marisa Lewis  Publisher 3dtotal Publishing  Price £30  Web www.3dtotalpublishing.com

Inspiration Books
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FEATURING 
ARTWORK BY 

WYLIE  
BECKERT

ORDER YOUR BINDER AT http://ifxm.ag/ifx-binder

This sturdy binder will store and protect 13 issues of ImagineFX.
Prices start at £9.99, which includes delivery!

GET YOUR 
BINDER TODAY!



98 Traditional art FXPosé
Explore this month’s selection  
of the finest traditional art,  
which was been sent in by you!

102 Workshop: The 
importance of storytelling
Iris Compiet reveals how she  
sketches and paints a fantasy 
character, and tells their story in 
a single image.
 
108 Workshop: Use 
texture in a ghostly scene
See how AM Sartor takes an 
indirect approach to traditional 
art, as she creates a surreal take 
on a classic mythological figure.

114 First Impressions:  
Jim Pavelec
This US artist found inspiration 
within a medieval grimoire.

This issue:

97June 2018

Inspiration and advice from the best pro artists
Traditional Artist
102 98

108 114

Workshops assets are available…
If you see the video workshop badge then you can watch the artist  

in action. Turn to page 8 to see how you can get hold of the video.

GET YOUR 
RESOURCES

See page 8 now!



Want to submit your work? Visit http://ifxm.ag/getinifx

SHOWCASING THE FINEST TRADITIONAL ARTISTS

2

Mike Stone

Mike freelances as a creative and storyboard artist in 

advertising. He’s working on a series of Siren paintings, 

each of which is rendered in a different colour.

LOCATION: England  MEDIA: Gouache, wax crayons, pencils  WEB: www.mikescribbles.com

1

1THE PRIMROSE PLANET

“I opted to play with scale here. Most of the 

characters I create are small, cute and quirky, 

so taking a more realistic approach was a 

different sort of challenge.”

2COBALT QUEEN

“I first drew this in a sketchbook way back 

in 2009, and decided to recreate it in 

gouache. This is the first in my ongoing series 

of femme-themed paintings.”

3A VIEW IN VERMILION HUES

“Have you ever tried to paint straight with 

a paintbrush? It’s harder than it looks! I had to 

buy an architect’s tool to render the lines on 

the pagoda. It was worth it, though.”

Traditional Artist FXPosé
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Want to submit your work? Visit http://ifxm.ag/getinifx

4MELTING IN MAGENTA

“It took a few attempts  

to get the colours balanced 

correctly on this one, but it 

was absolutely worth the pain.  

I usually have a vague idea of how 

an image should look; however,  

it rarely pans out as you expect.”

4

Inspirational art
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Want to submit your work? Visit http://ifxm.ag/getinifx

1

2 31HYBERNATION ODYSSEY

“Three brave friends embark upon 

the unfamiliar adventure of winter 

sleep. After collecting all their treats, 

they hop aboard their leaf and sail the 

impetuous winds of autumn.”

2TAKING FLIGHT

“I’m always reinventing the modes 

of transport that my characters use as 

they explore the big wide world. I’m 

fascinated by magpies, and their 

monochrome feathers inspired me to 

make this painting during Inktober.”

3BRAVE THE STORM

“I wanted to create an action shot 

for this painting. I used multiple 

painted layers to create the artwork.”

Nadya Bonten-Slenders
LOCATION: The Netherlands  MEDIA: Ink and watercolour  WEB: www.nadyart.nl

Freelance artist Nadya enjoys creating whimsical worlds for 

adults to escape to and revisit their childhood. Her work often 

centres on small animals, venturing out to discover the world.

Traditional Artist FXPosé
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Want to submit your work? Visit http://ifxm.ag/getinifx

4 4WINTER

“I love to experiment 

with multiple layers and 

contrast. Black ink offers 

me the freedom to explore 

these techniques. I’m 

intrigued by images that 

also incorporate a cute 

side with a tiny bit of dark.”

5

5MY UNIVERSE

“Motherhood is a 

theme I like to feature  

into my work. This image 

portrays a mother and 

baby being carried by  

the night sky.”

Inspirational art
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WatercolourPencil

 F
or my book Faeries of the 

Faultlines, I’ve been 

exploring the world of 

faeries, discovering new 

creatures and characters  

in every sketch I make. In this 

workshop, I’d like to show you how 

such characters evolve from a simple 

idea in my sketchbooks, how their 

story begins to form and how this 

will bring your characters to life. 

For me, the story of a character,  

its purpose in life, his or her likes, 

dislikes, personality, clothing and  

so on can help to create an engaging 

image. I recently discovered a creature 

I’ve called Harry. Harry is a 

hobgoblin, and he takes care of 

orphaned owl chicks. That’s his 

purpose, that’s his story, and in this 

workshop I’ll show you how I get 

from a single quick sketch of a rough 

idea to a final illustration that tells 

the story of Harry. 

I prefer to work in watercolour  

for these type of character 

illustrations. Watercolours have some 

great properties. For example, they 

dry quickly and you always have the 

option of using a hair dryer to speed 

up the process. But there are a lot of 

awkward aspects to watercolour. 

They’re sometimes difficult to 

control, colours dry differently to 

their wet appearance, you need to 

plan ahead, and there’s hardly a way 

to go back to the white of the paper  

if you make a mistake. Having said  

all this, it does offer the potential  

of plenty of happy accidents!

I prefer to work on Arches Hot 

Pressed 140lbs paper, stretched on a 

wooden board. I loosely transfer the 

final sketch on to the stretched paper 

using baking paper instead of vellum 

or tracing paper. Since you can’t use  

a lightbox when you work on wooden 

boards, it keeps costs down. I only 

trace the main lines and sketch the 

final details directly on to the paper 

very lightly. I don’t want to leave too 

many marks on the paper – it might 

damage the surface and create 

unexpected problems as I go along.

THE IMPORTANCE  
OF STORYTELLING

Make sure you’re sitting comfortably, as IRIS COMPIET reveals how she  

sketches and paints a fantasy character, and tells their story in a single image

 
Iris lives and works in the 

Netherlands where she paints 

fantasy and folklore images of 

the weird and wonderful for 

a range of clients. She’s the creator of the 

art book Faeries of the Faultlines. You can 

see more of her work at www.eyeris.eu.

ARTIST INSIGHT

THE PERFECT 

PALETTES

If you want to avoid 

buying paint palettes, 

consider plain white 

plates! I like to use 

Ikea’s square ones – 

they’re actually for 

candles. I can stack 

them on top of each 

other in an attempt to 

keep cat hairs or dust 

from getting in when 

I’m not working.

©
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In depth Storytelling
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1
Getting to know my character
Drawing full-body sketches of my character in simple poses helps me  

to develop his personality, and to see what I like about him. This also helps me to 

figure out how he moves or what his build should be. Exploring these body aspects 

is essential because they’ll help shape the story. It’ll bring your character to life.

3
Transferring the sketch
I transfer the final sketch using baking paper. 

Graphite transfers easily on to the watercolour paper 

because of the anti-sticking coating. I transfer the basic 

shape and finish the final sketch on the paper. I keep my 

marks light so as not to damage the surface.

2
Gathering reference
I find reference based on my sketches, although 

taking your own photos of objects or recreating a pose  

of the character is even better. My references are rough 

guides that give me ideas for colours and certain looks.  

I never copy from them. The clothing of your character  

is crucial: the way they dress says something about them. 

4
First light watercolour washes
After I wet the paper, I go in with a first wash –  

a mix of Shadow violet and Payne’s Blue gray. I establish 

some base values, and find shadows and highlights. This 

doesn’t have to be exact, and I’m not worried if the colour  

bleeds into areas I might not want it to.

MATERIALS

PENCILS 

 Graphgear 1000 

Pentel, 0.7mm

 Prismacolor Col-

Erase Tuscan red  

and Brown

 Faber-Castell 

Polychromos white and 

yellow

PAPER

 Arches Hot Pressed 

140lbs, stretched on 

wooden board

BRUSHES

 Daler Rowney Rigger

 One very old 

watercolour brush 

 Traditional Asian 

calligraphy brushes

WATERCOLOUR PAINT

 Daniel Smith: Van 

Dyck brown, Sepia, 

yellow ochre, Indian 

red, Deep scarlet, 

Potter’s pink, Payne’s 

blue gray, Mayan blue 

genuine, Cerulean blue, 

Shadow violet, 

Serpentine genuine, 

Olive green, Undersea 

green

 Sennelier: Greenish 

umber, Raw sienna 

Traditional Artist Workshop
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5
Apply more colour
A second wash comprises some Ochre I blend into 

the still-damp first layer to warm up the nest and parts  

of the tree. There’s no need to be precious in any of these 

initial washes – I like to keep things loose and translucent.

7
Colouring the owls
Even though the owls in this piece aren’t meant  

to be lifelike, I want to keep their colouring true to nature, 

in line with the earthy palette I’m using. I want Harry  

to be the focal point, so your eye gets pulled towards  

him rather than darting around the painting.

6
Base tone for the face
Because he’s the focal point, it’s important to get 

Harry’s face established in the early stages. Light washes 

of skin tone help to build up his face, and using wet-in-wet 

technique on certain areas enables the red to bleed into 

the underlying washes. This gives his face a natural glow.

8
Tap into the properties of paint
Some of the Daniel Smith colours haver certain properties, such as a 

granulation effect. This works perfectly to create the feel of fluffy owl feathers.  

So aside from using the wet-in-wet technique to help create textures, you can also 

use the properties of your medium.

WORK 
TIP

PAINT STEADILY

Rest between creative 

sessions. Refresh your 

mind, step away and  

then come back to  

your piece with 

fresh eyes.

ARTIST INSIGHT

SHARE YOUR ART

I like seeing how artists 

create more than their 

final pieces, so I urge 

you to share your 

process online. 

Sketches or WIP 

images will engage 

people in what you’re 

working on. You might 

even get some helpful 

tips on how to fix 

something you’re 

struggling with!

In depth Storytelling
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9
Continue with the washes
I’m using the wet-in-wet technique a lot. I like the way the pigments mix 

while still wet, because it creates some natural colour variations. Particularly when 

painting objects like trees, this property can be very helpful in creating a realistic 

bark texture. In addition, I don’t want too many hard edges at this stage.

12
Don’t be afraid to make changes
I take a step back from the piece and notice that 

there’s too much of the same colour. I need a contrasting 

colour to attract attention towards Harry. I decide to 

change the colour of his hat from green to red, and this 

immediately solves my problem of the subject getting 

lost in his surroundings.

11
Trail of mushrooms
Adding mushrooms to the tree trunk creates an 

interesting visual. Using a mini mister (a small atomiser),  

I wet the paper. By using one of these I don’t have to 

touch the paper and don’t risk lifting pigment. I use the 

same colour for the mushrooms that I chose for the scarf. 

This helps me guide the viewer’s eye towards Harry.

10
Defining detail
I like to define certain details using a Col-Erase 

pencil. It generates a crisp line and blends well with 

watercolour. If you go over it with a damp paintbrush  

you can soften up the line. Don’t push too hard, though. 

You don’t want to make marks you can’t erase or change.

ARTIST INSIGHT

THE IMPORTANCE  

OF WATER

Keep two containers of 

water at hand: one to 

rinse your dirty brushes 

in and one to use when 

you need to wet an area 

of your paper.

PROCESS 
TIP

EMBRACE MISTAKES

Don’t be afraid to start 

over when a piece isn’t 

working. Retrace your 

steps, see what’s 

wrong and get  

to work.
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13
A leafy illusion
I paint the background with several washes  

of different colours. This creates the illusion of a leafy 

setting, without having to detail countless leaves. I use  

a brush with clean water to pick up the pigment in certain 

areas. This simulates light coming through the leaves and 

results in an interesting mix of detailing and suggestion.

14
Painting bark
I find the best way to add texture to the tree is to pick up and refine what’s 

already there. The way the pigment, water and paper work together creates 

texture, and by refining what’s already there I can create a natural texture. However, 

I don’t refine everything and leave certain areas untouched.

15
Bringing in some final touches to the painting
For the final detailing, I use some Faber-Castell Polychromos white and yellow pencils to add some highlights on the rims of the 

mushrooms, Harry’s hat, the scarf and in some owl feathers. The nest receives some final detailing touches using a Col-erase pencil. 
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GET YOUR 
RESOURCES

See page 8 now!

GouacheMarkerPencil

W
hen I first started 

out as an 

illustrator, I 

painted everything 

traditionally. The 

software to create art wasn’t as robust 

as it is now, so I couldn’t produce the 

finished product that I wanted from 

the limited tools offered. 

Once the software started to 

improve, I saw the potential of 

working digitally and developed a 

process to mimic my traditional style. 

It worked pretty well, and was much 

faster than working traditionally. 

Yet my work seemed to lose some 

of the spontaneity that had been 

easier to achieve with traditional 

media. So with an improved skill set 

to apply to my work, I’ve developed a 

traditional process that takes 

advantage of some of the flexibility of 

digital tools while still incorporating 

the unpredictability of natural media.

My favourite topics to paint are the 

surreal and supernatural. I often 

incorporate fairy tale symbolism into 

my work. Creating an atmosphere 

that’s haunting is essential to my 

style. With this workshop I’ll reveal 

how my tendency to build up details 

slowly and allow underlying layers to 

show through in the final can add an 

otherworldy quality. I also show how 

using mixed media can lead to 

interesting and unique results.

It’s important to learn how to make 

mistakes. To understand a process  

I have to know how to correct it,  

and how to let some mistakes be. 

Confidence is something that shows 

through in your personal style. By 

knowing that if I mess up I can 

correct the mistake – and sometimes 

even improve on the final result –  

I feel a sense of security in taking 

risks on the canvas that I wouldn’t 

otherwise feel comfortable making.

I work in a limited palette, almost 

grisaille, so that I can focus on form 

and value. The subtleties that I can 

express with a limited colour range 

are well suited to describing surreal 

and dreamlike scenes. When I 

establish a strong value structure and 

an interesting composition, adding 

colour becomes a much easier task. 

Knowing that placing a warm grey 

next to a cool grey will make the 

former read as brown and the latter 

as blue is essential to understanding 

colour. Most of my recent art is in  

a cool limited palette, and I 

occasionally add a key colour when 

it’s important to the narrative.

USE TEXTURE IN  
A GHOSTLY SCENE

AM SARTOR takes an indirect approach to a traditional painting – follow along  

as the illustrator creates a surreal take on a classic mythological figure

 
AM Sartor is a freelance 

illustrator whose work has 

been featured at Krab Jab 

Studio, Light Grey Art Lab, 

Ghost Gallery, Every Day Original, 

Spectrum and SI-LA Illustration West.  

See more at www.amsartor.com. 

ARTIST INSIGHT

ANTICIPATING 

MISTAKES

I like to work in a way 

that allows me to make 

mistakes. Printing my 

underpainting onto my 

watercolor paper 

allows me to start over 

without having to redo 

my initial steps.
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1
Thumbnailing to generate ideas
I start with a pencil sketch on cream-coloured paper. Originally I began this 

piece as a horizontal composition, so I had to make some changes to get it to work 

as a portrait. I usually spend less than half an hour on each thumbnail. This stage  

is for generating ideas and figuring out the general composition.

3
Graphite underpainting
I tape a sheet of polypropylene vellum to my 

screen, which acts as a light box. Now I can easily transfer 

the sketch by tracing and then refine the details. Working 

on polypropylene can be tricky to get used to, but it does 

allow for reworking. I can also build up some interesting 

textures at this stage, but I don’t want to spend too much 

time on the underpainting.

2
Create a refined sketch
At this stage I’m working on the computer. This 

enables me to quickly make corrections, add new layers 

for ideas, and refine without worrying about overworking 

media. I also double-check all my shapes and dimensions, 

because creating those on the computer is much more 

precise than drafting them by hand.

4
Underpainting with walnut ink
This step is on the opposite side of the vellum from 

the graphite drawing. By painting freely with the walnut 

ink, I get a better sense of the flow of the painting, and 

create some interesting texture to work on top of. I’m also 

able to establish my value structure.

TOOL 
TIP

THINK LATERALLY

Household cleaning 

items sometimes make 

the best textures. When I 

want to fill a large space 

quickly, a paper 

towel is ideal.

MATERIALS

MEDIA

 Faber-Castell 

Polychromos Cool grey 

coloured pencil, Faber-

Castell Pitt artist pens, 

white gouache, white 

pastel, walnut ink, India 

ink, graphite

TOOLS 

 Molotow felt tips, 

Princeton Select Grainer 

brush, Liner brush and 

Oval mop, Q-tips, paper 

towels, paper smudgers

SURFACE

 140lb hot pressed 

watercolour paper, 

wood panel, PVA glue, 

white gesso
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5
Produce a small-scale study version
I have an easier time and am more confident in my 

decisions when I create a small version of the larger 

painting I’m going to create. It doesn’t need to be 

detailed, just large enough to test out the value structure 

and make sure the composition holds up when reduced.

7
Defining light shapes
Once I’ve applied the gouache layer I need to 

ensure my shapes are well defined before I make more 

decisions. I don’t focus on the details inside of the shapes 

because these might be lost in a later step. I only tackle 

the areas where there’s an abrupt change in value.

6
Apply a layer of gouache
After printing my underpainting lightly on high-quality watercolour paper,  

I apply a thin layer of white gouache to the surface. It creates a barrier between  

the pigment and the paper so that I can move the media around and wipe away 

mistakes without doing too much damage to the paper. I use permanent white,  

but if it needs to be more translucent, zinc white can be applied.

8
Bring in some dark shapes
Now I can fill in the dark areas with India ink. I leave a little room around the 

light shapes and then blend the ink to give it a soft edge. If I’ve applied enough 

gouache on the underlayer then the blending is easy. I do this with a spent felt  

tip marker or one of my Molotow refillables.
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9
Building up texture
Although I’ll be building up texture throughout the process, now is a good 

time to lay down the broad strokes. I use a balled-up, damp paper towel and 

smudge the ink to create a sculptural sense of form. Sometimes the paper towel  

will start to dissolve, or the paper will begin to pill. Allow the paper to dry and  

then smooth away the raised texture with a dry, clean rag.

11
Correcting the ghostly hands
The right hand feels inelegant to me, and is disrupting the flow of the painting. With a clean, damp felt tip 

marker I scrub out the hand. Once the paper is dry, I use a rag to smooth down any raised fibres, after which I put 

down a thin layer of gouache. Now I can redraw the hand from scratch.

10
Refining edges
The painting looks pretty messy, so it’s time to pull 

in some of those details. Edges are important. I try to 

avoid outlining, although it’s a natural tendency for me.  

I try to turn my edges to create more depth, and give  

my work a sculptural quality. I use coloured pencils that 

smudge beautifully on the gouache surface. For a softer 

gradation I use a dry smudger, while for a more painterly 

stroke I use a felt tip marker filled with water.

ARTIST INSIGHT

HIGH-QUALITY 

MATERIALS

For my process it’s 

essential that I use  

well-sized paper that 

can take reworking. 

Arches 140lb hot 

pressed watercolour 

paper can be gently 

sanded and still take 

wet media without 

being destroyed.

ARTIST INSIGHT

STRETCHING  

YOUR PAPER

I permanently adhere 

my watercolour paper 

to a wood panel using 

archival PVA. No matter 

what I do to it the 

surface remains flat, 

and it looks clean for 

hanging or framing.
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12
Emphasising the head
The head, along with the hands, are easy focal 

points, so I spend time getting it right. Tackling modelling 

shadows and cast shadows below the nose and chin and 

getting the shapes correct will lend character to a face.

13
Drawing butterflies
The butterflies are a key value, and also act as a focal point. I use gouache  

to highlight the wings, and a grey coloured pencil to draw subtle shadows. I want 

them to be otherworldly, so they require a light touch.

14
Adjusting dark values
I reapply my India ink in the dark areas. I lose some 

interesting texture, but the painting will be too busy if  

I don’t even out these areas. I use a thin layer so there’s 

still depth and I’m careful not to ruin the edges that I’ve 

carefully established. I use the wet paper towel to adjust 

the modelling shadows in lighter areas.

15
Tweaking light values
Now I can go back and fill in the lighter details.  

I also go over the dark areas with white pastel, which  

I smudge to create a gradation. For texture I use a Grainer 

brush that’s been cut to resemble a comb. This part of  

the process is meditative for me: I enjoy drawing in small 

details and creating texture. Once the painting is finished 

I spray it with a casein-based workable fixative. 

RECYCLE 
TIP

SPENT FELT TIP PENS

When a felt tip pen runs 

dry I’ll use it for smudging 

and washes. They’re also 

great for scrubbing out 

minor errors and 

blending.

In depth Use texture

113June 2018



Where did you grow 

up and how has this 

influenced your art? 

I grew up in St. Louis, 

Missouri. It’s a very 

conservative, Christian place and 

from a very young age I knew that 

mind set wasn’t for me. I rebelled 

against the religious dogma being 

spewed at me, and that rebellion 

fuelled my artwork.

What, outside of art, has most 

influenced your artwork through 

the years? 

Music. The soundtrack to religious 

rebellion since the 1970s has been 

metal. Speed and Thrash, Death and 

Black. I love it all. When, at 14, 

you’re hearing only one incredibly 

narrow point of view, and then you 

hear Slayer’s front man bellow, 

”Learn the sacred words of Praise 

Hell, Satan!” over a thunderous 

drum beat and some of the most 

sinister guitar riffs ever… well, 

there’s really only one path worth 

choosing after that.

What was your next step in art?  

Did other interests vie for your 

attention? What turned out to  

be the deciding factor? 

I was too stubborn to think about 

doing anything else, so after college 

I dove into a career in fantasy 

illustration. It took me almost  

20 years of being a freelance 

illustrator to realise that I was 

making the wrong art. About four 

years ago I stopped taking almost all 

freelance gigs and focused on my 

current occult-themed work.

Does one person stand out as being 

helpful during your early years 

working as an illustrator? 

During my early art career, I was 

fortunate to meet and develop a 

friendship with the great illustrator 

William O’Connor, who 

unfortunately passed away recently. 

Bill showed me more about being a 

professional illustrator than any 

other person. He was a tremendous 

human being and a great artist.

What advice would you give to your 

younger self to aid you on the way? 

Find a way to do what you really 

want to do, and focus on the quality 

of your work instead of the quantity.

What projects are you currently 

working on?  

At the moment I’m working on 

reimagining the 72 demons of the 

Ars Goetia. This is a grimoire 

compiled in the Middle Ages, listing 

the demons King Solomon conjured 

to build the First Temple. 

Once I gave up freelance I 

struggled to find the right venue for 

my new work. After finishing a 

drawing one day, I clearly realised 

that it was a demon of the Goetia.  

I grabbed my copy of the book and 

devoured it once again. How had  

I been so blind? It was with me all 

these years. Part of me believes my 

skills hadn’t reached a high-enough 

level to embark on this journey 

previously. I don’t think I was 

mentally prepared for it. 

Since beginning this project, I’ve 

experienced an explosion of creative 

energy. I entirely changed the way I 

draw and paint to meet its demands. 

I have a new-found courage to 

explore techniques and media, 

which I was afraid to do during  

my illustration years due to the 

constraints of deadlines. 

Upon completion of my 

interpretations of the demons, I 

want to publish a fully illustrated 

version of the book, complete with 

new descriptions of the demons 

based on my experiences with them. 

Watch this space!

Jim has been illustrating and writing for 

nearly two decades. His books include Ink 

Bloom, and Hymns & Wretched Offerings 

To The Golden Ones. Keep up with his 

latest project at www.arsgoetia.net.

VASSAGO
Switching between digital and 
traditional media enables me to 
achieve colour palettes and edge 
work that I wouldn’t have 
thought of in my old style.

MALTHUS
I use both live models and photo 
reference from the internet to get 
the figure to where I want it.

 Since beginning this project, 
I’ve experienced an explosion 

of creative energy 

Traditional Artist Interview

114 June 2018

First Impressions
Jim Pavelec

This US artist has 

found new inspiration 

within the pages of a 

medieval grimoire
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